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Welcome to Sprint

We are committed to bringing you the best wireless technology available, and we 
built our network right from the start, so no matter where you are on the network, 
all your services will work the same.

When it comes to mobile connectivity, the Sprint Mobile Broadband card offers 
more freedom than ever before. No wires, no cables, just access to your data when 
you need it. The power of the Internet and company data is truly at your 
fingertips.

This guide will familiarize you with our technology and with Sprint Connection 

ManagerSM software with enhanced Local Search (for Windows computers), 
Watcher® Lite software (for Mac computers), and your new Sprint Mobile 
Broadband card through simple, easy-to-follow instructions.

Welcome and thank you for choosing Sprint.
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Introduction

This User’s Guide introduces you to Sprint service and all the features of your new 
wireless Sprint Mobile Broadband card. It’s divided into seven sections:

� Section 1:  Basics of Your Card

� Section 2:  Installing the Card

� Section 3:  Using the Card on a Windows Computer

� Section 4:  Using the Card on a Mac

� Section 5:  Technical Specifications and Regulatory Information

� Section 6:  Safety Information and Terms & Conditions

� Section 7:  Glossary and Index

Throughout the guide, you’ll find tips that highlight special shortcuts and timely 
reminders to help you make the most of your ExpressCard modem and services.

The Table of Contents and Index will help you locate specific information quickly. 
The Sprint Connection Manager software (for Windows) includes extensive online 
help to guide you through the steps to use each feature.

You’ll get the most out of your new Sprint Mobile Broadband card if you read each 
section of this document. However, if you’d like to get right to a specific feature, 
simply go to that page. Follow the instructions in that section and you’ll be ready 
to use your card in no time.

Tip: You can view this guide online or print it to keep on hand. If you’re viewing it online, 
simply click a topic in the Table of Contents, a page number in the Index, or any page 
or section reference. The PDF automatically displays the appropriate page.



Section 1

Basics of Your Card
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Sec tion 1A

Introducing the Sprint Mobile Broadband 
Card

In This Section

� Your Sprint Mobile Broadband Card

� CDMA Networks

� TRU-Install

� One Touch Activation

� Package Contents

� Care and Maintenance

� About This Guide

This section introduces the basic features and functions of your Sprint Mobile 
Broadband card, what is included with your card, and how to use this guide to get 
you started.
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Your Sprint Mobile Broadband Card

The Sierra Wireless AirCard® 597E ExpressCard is a dual-band wireless 
ExpressCard modem. It enhances the functionality of your mobile computing 
devices by adding wireless data.

This card allows you to do the following (subject to feature availability), without 
using a landline network or phone:

� Easily activate your account (One Touch Activation)

� Connect to the Internet, VPNs, and corporate networks

� Send and receive large email messages

� Use Sprint Location Services (Windows® only)

� Conduct Internet-based videoconferencing

� Access streaming real-time media

� Play games online

Your card fits into an ExpressCard/34 slot,  ExpressCard/54 slot (available on 
newer notebook computers), or PC Card slot (when used with the included 
ExpressCard to PC Card adapter) available on older notebook computers.

CDMA Networks

The card operates over a type of wireless network called CDMA (Code Division 
Multiple Access).

To use the card, you need an account that gives you access to the CDMA network. 
Some features described in this manual may not be available with your account. 
For details of the services and accounts available, contact Sprint (page 14).

There are CDMA networks that operate in the frequency bands supported by the 
card throughout North America. However, each service provider operates a 
network that covers a limited geographical area within the overall CDMA 
coverage area.

The fee for service may be higher when you are roaming (connecting to a network 
other than Sprint).

Sprint has “roaming” agreements with other service providers, so that you can get 
service outside of the coverage area of the network. (There may be additional 
charges for roaming service.)
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CDMA technology provides a variety of connectivity features, depending on your 
Sprint account (actual speed depends on the network conditions):

� 1xEV-DO Rev. A (Sprint Power VisionSM) supports Internet connections with 
data rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to 
the network). Average data rates are 600 kbps - 1.4 Mbps (downlink from the 
network) and 350-500 kbps (uplink to the network).

� 1xEV-DO Rev. 0 (Sprint Power Vision) supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 153 kbps (uplink to the 
network). Average data rates are 400-700 kbps (downlink from the network) 
and 40-80 kbps (uplink to the network).

� 1X (Sprint Vision) supports Internet connections with data rates up to 153 kbps. 
Average data rates are 40-80 kbps.

TRU-Install

TRU-Install  is a Sierra Wireless feature that installs the necessary software and 
drivers the first time you insert the card into your Windows or Mac computer. An 
installation CD is not required.

One Touch Activation

Where supported by the network, One Touch Activation (IOTA 2.4) lets you easily 
activate your card. When prompted, you simply click “Yes” to indicate that you’d 
like the network to autoprogram your card. If this is successful, you are ready to 
connect to the network.

Tip: More information about CDMA networks is available on the CDMA Development 
Group Web site, www.cdg.org.

Tip: For pointers on optimizing your settings, see “How can I optimize my settings to 
achieve the fastest speeds and conserve data when accessing my corporate 
network?” on page 101.

http://www.cdg.org
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Package Contents

Your Sprint Mobile Broadband card package contains the following components:

� Sprint Mobile Broadband card by Sierra Wireless (Model AirCard 597E)

� ExpressCard to PC Card adapter (needed only if your computer doesn’t have an 
ExpressCard slot)

� Getting Started guide

Care and Maintenance

As with any electronic device, the card must be handled with care to ensure 
reliable operation. Follow these guidelines in using and storing the card:

� The card should fit easily into your ExpressCard slot or ExpressCard to PC Card 
adapter. Forcing the card into the slot or adapter may damage the connector 
pins.

� Protect the card from liquids, dust, and excessive heat.

� When not installed in your computer, store the card in a safe place.

� Remove the card before storing or transporting your computer.

� When inserting or removing the card, always grip it by the sides rather than the 
end, as this prevents damage to the card (see diagrams on page 29).

� Do not use the card with a handheld computer; it is designed only for notebook 
computers running Windows Vista, Windows XP, Windows 2000, or Mac OS X.

� Do not handle or operate the card while driving or operating a vehicle. Doing so 
may distract you from properly operating the vehicle. In some states and 
provinces, operating communication devices while in control of a vehicle is a 
criminal offense.
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About This Guide

This user’s guide is designed to provide you with all the information you need to 
install and use your card by Sierra Wireless (AirCard 597E).

� Section 1 (which you are reading) gives you an overview of the card 
(AirCard 597E).

� Section 2 provides step-by-step instructions for installing the card and software 
on a Windows or Mac computer (page 15).

� Section 3 provides step-by-step instructions on using the card on a Windows 
computer (page 41).

� Section 4 provides step-by-step instructions for using the card on a Mac 
computer (page 109).

� Section 5 provides electrical, radio frequency, and other parameters of the card 
for those who require technical information, as well as regulatory information 
(page 133).

� Section 6 provides important safety and liability information and the Terms and 
Conditions of use for the Sprint Mobile Broadband card (page 147).

� Section 7 include a glossary (page 171) and index (page 176).

Note: The comprehensive Getting Started guide that comes with the 
Sprint Mobile Broadband card should be sufficient for most installations.
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Sec tion 1B

Getting Started With Your Card

In This Section

� Installation Overview

� System Requirements (Windows)

� System Requirements (Mac)

� Included Software

� Attaching an External Antenna

This section describes the basics of getting started with your card, and how to 
look after your card.
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Installation Overview

Before you begin using your card, you must install the card’s software and 
configure the card for your computer. The installation process consists of:

� Ensuring that your computer meets the system requirements.

� Inserting the card into your computer and installing the drivers for the card and 
the Sprint Connection Manager software (for Windows) or Watcher Lite 
software (for the Mac).

� Starting the software.

� Activating your Sprint account and configuring the card to use your account 
(unless the card has been preactivated).

System Requirements (Windows)

The Sprint Mobile Broadband card is supported on:

� Windows Vista.

� Windows XP with Service Pack 2.

� Windows 2000 with Service Pack 4 and high encryption support. (See “High 
Encryption Requirements (Windows)” on page 10.)

To install and run the card and accompanying Sprint Connection Manager 
software on a Windows computer, you will need the minimum system resources 
shown in the following table.

Note: To install the drivers and software, you do not need an installation CD. Your 
card uses the Sierra Wireless TRU-Install feature—the drivers and software 
are installed when you insert the card into your computer. (To get the latest 
drivers and software, you can always go to www.sprint.com/downloads.)

Slots One ExpressCard/34 or ExpressCard/54 slot; alternatively, a 
Type II PC Card slot (when used with the ExpressCard to 
PC Card adapter [included in your package]).

Memory 32 MB

Disk space 32 MB

http://www.sprint.com/downloads
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High Encryption Requirements (Windows)

Depending on your configuration, an IOTA (Internet Over The Air) session may 
automatically start as part of the installation process. IOTA requires high-security 
128-bit encryption to establish a secure Internet connection to the CDMA 
network. (For more information, see “Data Provisioning [IOTA]” on page 35.)

If you are running Windows Vista or Windows XP, your computer should already 
include high-security 128-bit encryption.

If you are running Windows 2000 with Internet Explorer
1. Ensure you have installed the Windows 2000 High Encryption Pack: in 

Internet Explorer, select Help > About Internet Explorer.

If you see “Cipher Strength: 128-bit,” then the High Encryption Pack is 
installed. Proceed to step 2.

If the High Encryption Pack is not installed, download and install it 
(www.microsoft.com/windows2000/downloads/recommended/encryption).

2. If your version of Internet Explorer is earlier than 5.5, download and install the 
latest version (www.microsoft.com/windows/ie/downloads).

If you are running Windows 2000 with Netscape Communicator

Ensure your version of Netscape Communicator is 4.7 or higher.

To verify that your version supports 128-bit encryption:

1. In Navigator, select Help > About Navigator. 

– or –

In Netscape Communicator, select Help > About Communicator.

2. See the section “Contains encryption software from RSA Data Security, Inc.” 

If the next paragraph states “This version supports U.S. security,” you have 
128-bit security.

If the paragraph states that you have International security, you have 40-bit 
security. Download a version that supports 128-bit security.

www.microsoft.com/windows/ie/downloads
www.microsoft.com/windows2000/downloads/recommended/encryption
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System Requirements (Mac)

The Sprint Mobile Broadband card is supported on a MacBook™ Pro or 
PowerBook® G4 computer running Mac OS X version 10.4 or newer.

To check your version, from the Apple menu ( ) choose About This Mac. If your 
version is earlier than 10.4, then you must upgrade to version 10.4 or newer; 
contact an Apple reseller, an Apple retail store, or visit www.apple.com/store.

If your card has not been activated, you may also need access to a telephone.

For technical support issues, please contact Apple. If you can’t recall your lock 
code, contact Sprint Customer Service.

Included Software

The Sprint Mobile Broadband card comes with the following software:

� Sprint Connection Manager, which allows you to manage the card’s actions and 
monitor your connections on a Windows computer

� Watcher Lite, which allows you to manage the card’s actions and monitor your 
connections on a Mac computer

� The driver software that forms the interface between the card and your 
Windows or Mac operating system

The appropriate software is installed the first time you insert the card into your 
computer.

Detailed instructions are provided beginning on page 17 (for Windows) and 
page 21 (for Mac).

Note: The Mac software (Watcher Lite) currently does not support Sprint Location 
Services.

www.apple.com/store
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Attaching an External Antenna

You can improve the signal strength by attaching an external antenna (sold 
separately).

To attach an external antenna:

1. Remove the card if it is inserted in your computer (page 28).

2. Remove the rubber cap (located on the thick end of the card).

3. Hold the antenna cable by the connector (end) part, and carefully insert the 
connector part of the cable into the corresponding connector on the card.
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Sec tion 1C

Getting Help

In This Section

� Visiting the Sprint Web Site

� Contacting Sprint Customer Service

� Troubleshooting

This section describes where you can find more information on Sprint services, 
options, and troubleshooting problems you might encounter.
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Visiting the Sprint Web Site

Stop by www.sprint.com and log on to get up-to-date information on Sprint 
services, options, and more.

You can also:

� Review coverage maps.

� Access your account information.

� Add additional options to your service plan.

� Purchase accessories.

� Check out frequently asked questions.

� And more.

Contacting Sprint Customer Service

You can reach Sprint Customer Service by:

� Logging on to your account at www.sprint.com.

� Calling us toll-free at 1-888-788-4727 (business use) or 1-888-715-4588 
(personal use).

� Writing to us at Sprint Customer Service, P.O. Box 8077, 
London, KY  40742.

Troubleshooting

The Online Help for Sprint Connection Manager on your Windows computer (see 
page 66) includes descriptions of most common error messages. Look in the 
Contents under Troubleshooting.

For help with other problems:

� See “Troubleshooting Tips (Windows)” on page 102 or “Troubleshooting Tips 
(Mac)” on page 116.

� Consult the Sierra Wireless Web site at www.sierrawireless.com, where you will 
find an extensive knowledge base that can be searched to address most 
problems, and the Installation Troubleshooting wizard (in the Support & 
Download section).

� Contact Sprint as noted above.

http://www.sprint.com
http://www.sprint.com
http://www.sierrawireless.com
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Sec tion 2A

Installing the Software on a Windows Computer

In This Section

� Installing the Software on a Windows Computer

This section explains how to install your Sprint Connection Manager software and 
Sprint Mobile Broadband card on a Windows computer.

The process may vary, depending on the version of Windows that you are running.

(If you’re using your card on a Mac computer, see “Installing the Software on a 
Mac Computer” on page 21.)
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Installing the Software on a Windows Computer

Before you can use your card, you must first install the card’s software and 
configure the card for your computer. The installation process consists of:

� Card insertion - Inserting the card, which automatically installs the drivers and 
the Sprint Connection Manager software on your computer (described in this 
section).

� Card activation and provisioning - Activating your Sprint account and configuring 
the card to use your account. (See “Setting Up Service [Windows]” on page 31.)

To install the software and drivers on your computer:

1. If your card has not yet been activated, ensure you are in the network 
coverage area (not roaming).

2. If your computer does not have an ExpressCard slot, ensure the ExpressCard to 
PC Card adapter (included in your package) is label side down, and insert the 
adapter into your computer’s PC Card slot.

Note: For comprehensive instructions on installing the Sprint Connection 
Manager software and activating the card, see the Getting Started guide.

Note: Windows Vista and Windows 2000 users: You must log in with 
administrative privileges to install the software and drivers.
Windows XP users: You may need to log in with administrative privileges, 
depending on your Windows configuration.

Before beginning the installation process, it is recommended that you close 
all open applications.
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3. With the picture label facing up, insert the card into your computer.

Windows detects the card and installs the drivers for it. This may take a few 
minutes. Once completed, the system tray may display “Your devices are 
ready to use” or “Your new hardware is installed and ready to use.”

The  LED is lit (blue, or blinking amber).

4. If the Software Installation Wizard has not started automatically, in Explorer 

browse to the entry, and run AppLaunch.exe or, if you’re running 
Windows Vista, in the “AutoPlay” window click Sprint Connection Manager 
Installation. This starts the wizard.

5. In the installation window, click Next.

6. Read the license agreement and select I accept the terms in the license 
agreement to indicate your acceptance of the terms. Click Next. (A series of 
dialog boxes guides you through the installation.)

7. Use the Next and Back buttons to navigate through the wizard.

8. When the “Installation Complete!” window is displayed, click Finish.

9. If you’re running Windows Vista or Windows XP, wait until the system tray 
displays “Your devices are ready to use” or “Your new hardware is installed 
and ready to use.”
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10. Run Sprint Connection Manager.

(Double-click the program’s icon [ ] on your desktop.)

11. If your card is preactivated or if you have activated it at the time of purchase, 
Sprint Connection Manager displays “Device locked” or “Disconnected;” 
proceed to “Preactivated Card” on page 32.

12. Proceed to “Non-preactivated Card: One Touch Activation” on page 33 if your 
card has not been activated.
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Sec tion 2B

Installing the Software on a Mac Computer

In This Section

� Installing the Software and Drivers on a Mac

This section explains how to install your Watcher Lite software and Sprint Mobile 
Broadband card on a Mac computer.



22 Section 2B: Installing the Software on a Mac Computer

Installing the Software and Drivers on a Mac

To install the Watcher Lite software and drivers on your Mac computer:

1. If your card has not yet been activated, ensure you are in the network coverage 
area (not roaming).

2. If your computer does not have an ExpressCard slot, ensure the ExpressCard to 
PC Card adapter (included in your package) is label side down, and insert the 
adapter into your computer’s PC Card slot.

3. With the picture label facing up, insert the card into your computer.

The “TRU-Install” Finder™ window is displayed.

4. In the “TRU-Install” Finder window, double-click 
SierraWirelessWatcherLite.mpkg.

Note: As part of the installation process you will be prompted to restart your 
computer; save any open documents.
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5. In the “Welcome to the Sierra Wireless Watcher Lite Installer” window, click 
Continue.

6. In the “Select a Destination” window, choose a destination volume. A green 
vertical arrow indicates which volume(s) you can install the software onto. If 
more than one volume has a green vertical arrow, select the volume that has 
the active operating system.

7. Click Continue.
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8. In the “Easy Install on ...” window, click Install. 

9. If the “Authenticate” window appears, enter your Mac user name and 
password, and then click OK.

10. In the window with the message that you will have to restart your computer, 
click Continue Installation.
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11. Click Restart. 

12. After your computer restarts, run Watcher Lite: in Finder, choose Go > 
Applications, and then double-click Sierra Wireless Watcher.

Watcher Lite should start:

Watcher Lite displays a status message or the “Device Not Activated” window.

Proceed to “Setting Up Service (Mac)” on page 36.
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Sec tion 2C

Inserting and Removing the Card

In This Section

� Inserting the Card

� Removing the Card (Windows)

� Removing the Card (Mac)

This section describes how to properly insert the card and remove it from your 
computer.



Section 2C: Inserting and Removing the Card      27

Inserting the Card

To insert the card into a notebook computer:

1. If your computer does not have an ExpressCard slot, ensure the ExpressCard to 
PC Card adapter (included in your package) is label side down, and insert the 
adapter into your computer’s PC Card slot.

2. With the picture label facing up, insert the card into your computer.

IMPORTANT! When inserting or removing your card, always grip the card by its sides, 
as this prevents damage to the card. See the graphics below.

Correct Incorrect
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When you insert the card into a Windows computer, the following should occur:

� The first time the card is inserted, Windows detects the card and installs the 
drivers for it. This may take a few minutes. Once completed, Sprint Connection 
Manager should display “Disconnected.” To connect to the network, click the 
GO button in the Mobile Broadband window.

� If sound effects are enabled, the computer beeps.

� The Unplug and Eject Hardware icon appears in the system tray, if it is not 
already displayed for another card (and unless the feature has been disabled).

The card is powered as soon as you insert it.

Removing the Card (Windows)

To remove the card from your Windows computer:

1. Exit Sprint Connection Manager if it is open (page 61).

2. Click the Unplug and Eject Hardware icon in the system tray:

3. Click the entry for “NEC PCI to USB Open Host Controller” or “Standard Enhanced 
PCI to USB Host Controller.”

4. If a dialog box appears notifying you that it is safe to remove the card, click 
OK, or click the Close button ( ).

5. Use your computer’s ExpressCard or PC Card ejector to eject the card from the 
slot.

IMPORTANT! When inserting or removing your card, always grip the card by its sides, 
as this prevents damage to the card.

Windows Vista Windows XP Windows 2000

Windows Vista Windows XP Windows 2000
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6. If you’re using your card (with the ExpressCard to PC Card adapter) in a 
PC Card slot, remove the card and adapter from your computer’s slot by 
gripping both sides of the adapter and pulling straight out.

– or –

Remove the card from your computer’s slot by gripping both sides of the card 
and pulling straight out.

Correct Incorrect
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Removing the Card (Mac)

To remove the card from your Mac:

1. End your network connection (in Watcher Lite, click Disconnect).

2. Eject the card from the slot.

3. If you’re using your card (with the ExpressCard to PC Card adapter) in a PC Card 
slot, remove the card and adapter from your computer’s slot by gripping both 
sides of the adapter and pulling straight out.

– or –

Eject the card from the slot, and remove the card from your computer’s slot by 
gripping both sides of the card and pulling straight out.

IMPORTANT! When inserting or removing your card, always grip the card by its sides, 
as this prevents damage to the card.

Correct Incorrect
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Sec tion 2D

Setting Up Service (Windows)

In This Section

� Activating and Using Sprint Service

� Preactivated Card

� Non-preactivated Card: One Touch Activation

� Non-preactivated Card: Activation Wizard

� Data Provisioning (IOTA)

This section walks you through setting up service for your Sprint Mobile 
Broadband card after you have inserted the card and installed the 
Sprint Connection Manager software (page 18).
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Activating and Using Sprint Service

Before using your card, you must have a Sprint wireless network account set up. 
The process of setting up an account is called activation.

When the card is inserted and Sprint Connection Manager is started, it will detect 
whether the card has been configured with an account (“preactivated”). If it has 
not, the “One Touch Activation” window or the Activation Wizard starts 
automatically.

Preactivated Card

If you received your card in the mail or purchased it at a Sprint Store, it probably 
has already been activated.

To prevent unauthorized use, preactivated cards may have been set with a security 
lock. If so, Sprint Connection Manager displays the message “Device locked.”

To unlock your card:

1. Click the  icon. (If is not visible, in the Mobile Broadband window click  to 
expand Sprint Connection Manager.)

2. In the “Enter User Lock Code” window, enter your four-digit lock code, and 
click OK. For security purposes, the code is not visible as you type.

After unlocking your preactivated card, it is ready for use. See “Using the Card on a 
Windows Computer” on page 41.

Tip: If you can’t recall your lock code, try using the last four digits of your card’s 
phone number (MDN). If this doesn’t work, call Sprint Customer Service at 
1-888-788-4727 (business use) or 1-888-715-4588 (personal use).
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Non-preactivated Card: One Touch Activation

If the “One Touch Activation” window appears, click Yes to indicate that you’d like 
to have the network autoprogram your card.

Sprint Connection Manager will display “Updating User Profile.”

If One Touch Activation is successful, Sprint Connection Manager will then display 
“Disconnected,” after which you are ready to connect to the network. (Click the GO 
button in Sprint Connection Manager.) To learn about using the software, see 
“Using the Card on a Windows Computer” on page 41.

If One Touch Activation was not successful, a message window is displayed. To 
activate your card, use the Activation Wizard (see the next section).

Non-preactivated Card: Activation Wizard

If your card is not preactivated, please see the Getting Started guide included with 
your card.

The Activation Wizard will guide you through the activation process.

To set up your account, you will be contacting Sprint.

Before you call Sprint, have these things ready:
� A phone

� Your card

� The city and state where the card will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

Note: If you successfully activated your card through the “One Touch Activation” 
window (page 33), skip these steps and go directly to “Using the Card on a 
Windows Computer” on page 41.



34 Section 2D: Setting Up Service (Windows)

When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your card’s activation code (gives you access to configure the account)

� Your card’s phone number (MDN)

� Your card’s MSID (Mobile System ID) code, used for WLNP (Wireless Local 
Number Portability) and to determine whether you are “home” or “roaming”

Stepping Through the Activation Wizard
If the Activation Wizard has not started automatically:

1. Ensure the card is inserted, and Sprint Connection Manager is running. If 
Sprint Connection Manager is not running, select:
(Windows Vista or Windows XP) Start > All Programs > Sprint > Sprint Mobile 
Broadband (Sierra).
(Windows 2000) Start > Programs > Sprint > Sprint Mobile Broadband (Sierra).

Sprint Connection Manager should display “Disconnected.”

2. If Sprint Connection Manager displays “Device locked,” unlock the card 
(page 69).

3. If Sprint Connection Manager displays “Device powered off,” power the card 
on (page 52).

4. Start the Activation Wizard: select MENU > Settings > Sprint Mobile Broadband - 
Sierra Wireless > Activation Wizard.

Once the Activation Wizard is running:

1. To begin activation of the card, click Next.

2. Call Sprint at the appropriate phone number listed on the screen. Click Next.

3. Give the account representative your ESN (Electronic Serial Number) or MEID 
(Mobile Equipment IDentifier) number as displayed by the Activation Wizard. 
Enter the activation code provided by the account representative and 
click Next.

4. Enter the phone number (no spaces or hyphens) and, if not the same value as 
the phone number, the MSID value given by the account representative, and 
then click Next.

A confirmation window will be displayed.

5. Confirm with the service representative that the information is correct. If it is, 
click Yes. If it isn't, click No, and re-enter the information.

6. Click Finish to close the Activation Wizard.
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7. Wait a few moments for the card to automatically reset. Depending on your 
configuration, an IOTA session may automatically start. (See “Data 
Provisioning [IOTA]” on page 35.)

After Sprint sets up your account on the network, your card should be configured 
and ready for use. To learn about using the software, see “Using the Card on a 
Windows Computer” on page 41.

Data Provisioning (IOTA)

IOTA (Internet Over The Air), supported by some service providers (including 
Sprint), is an automated feature to perform account setup for you by making a 
connection to the CDMA network and using a secure Internet connection to 
download account parameters to your card. To make this secure connection, IOTA 
requires that your computer support 128-bit encryption. (See “High Encryption 
Requirements (Windows)” on page 10.)

Depending on your configuration, the first time Sprint Connection Manager 
detects the activated card, an IOTA session may automatically start, during which 
status messages (“Updating User Profile…”) are displayed.

After this first activation, there may be changes to your account that require 
updating the parameters in the card. If this is needed:

1. In the “Device Info & Diagnostics” window (page 89), click Update Data Profile. 
(If this button is not displayed, remove and reinsert the card.)

2. In the “IOTA Provisioning” window, click Yes.

Your card then retrieves the updates to your data services account. Once the 
updates are successful, Sprint Connection Manager is displayed (“Disconnected”). 
You can now connect to the network. To learn about using the software, see 
“Using the Card on a Windows Computer” on page 41.
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Sec tion 2E

Setting Up Service (Mac)

In This Section

� Activating and Using Sprint Service

� Activating Your Card

This section walks you through setting up service for your Sprint Mobile 
Broadband card, after you have inserted the card into your Mac computer and 
installed the Watcher Lite software (page 22).
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Activating and Using Sprint Service

Before using your card, you must have a Sprint wireless network account set up. 
The process of setting up an account is called activation.

Activating Your Card

After you have inserted the card into your computer and started Watcher Lite, 
Watcher Lite will detect whether the card has been configured with an account 
(“preactivated”). If it has not, Watcher Lite displays a message (“Not activated”) or 
the “Device Not Activated” window. Use the following table to determine your 
next actions:

Text/window 
displayed

Description/next action

“Disconnected” Your card is preactivated. You are ready to connect to the 
network. (Click the Connect button in Watcher Lite.)

� Proceed to “Your Card: The Basics (Mac)” on page 110.

“Device is 
Locked”

Your card is preactivated. Unlock the card:

1. If the “Unlock Device” window is not displayed: from the 
Extras item on the Sierra Wireless Watcher menu, choose 
Unlock Device.

2. In the “Unlock Device” window, enter the lock code (PIN), 
and click OK.

� If you can’t recall your lock code, try using the last four 
digits of your card’s phone number. If this doesn’t work, 
call Sprint Customer Service at 1-888-788-4727 (business 
use) or 1-888-715-4588 (personal use).

3. Proceed to “Your Card: The Basics (Mac)” on page 110.
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Activation Assistant

The Activation Assistant will guide you through the activation process if your card 
is not preactivated.

To set up your account, you will be contacting Sprint.

Before you call Sprint, have these things ready:
� A phone

� Your card

� The city and state where the card will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

“Device Not 
Activated” 
window

Your card is not activated.

� Click Yes to indicate that you’d like to activate your card. 
Watcher Lite will display “Updating User Profile.”

If provisioning is successful, Watcher Lite displays 
“Disconnected,” after which you are ready to connect to the 
network. (Click the Connect button in Watcher Lite.) Proceed to 
“Your Card: The Basics (Mac)” on page 110.

– or –

If the “Data Provisioning” window displays “Provisioning 
failed,” use the Activation Assistant (below).

“Not activated” Your card is not activated.

� Use the Activation Assistant (below).

Note: If you close the Activation Assistant before finishing the card activation, you 
can start the Activation Assistant later. (From the Extras item on the Sierra 
Wireless Watcher menu, choose Activation.)

Text/window 
displayed

Description/next action
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When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your card’s activation code (gives you access to configure the account)

� Your card’s phone number (MDN)

� Your card’s MSID (Mobile System ID) code, used for WLNP (Wireless Local 
Number Portability) and to determine whether you are “home” or “roaming”

To activate your card and account:

1. From the Extras item on the Sierra Wireless Watcher menu, choose Activation.

2. In the “Activation Assistant” window, click Continue.

3. Call Sprint at the appropriate number displayed in the Activation Assistant.

4. Follow the instructions of the account representative to activate your card.

5. To complete the activation process, enter the information (from the account 
representative) into the fields on the screen.

6. Continue through the Activation Assistant, until the “Success!” window is 
displayed. Click Finish.

After Sprint sets up your account on the network, your card is activated.

7. From the Extras item on the Sierra Wireless Watcher menu, choose Data 
Provisioning.

8. In the “Data Provisioning” window, click OK.

The card then retrieves the updates to your account. Watcher Lite will display 
“Updating User Profile,” then “Disconnected,” after which you are ready to 
connect to the network. (Click the Connect button in Watcher Lite.) Proceed to 
“Your Card: The Basics (Mac)” on page 110.
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Sec tion 3A

Your Card: The Basics (Windows)

In This Section

� Sprint Connection Manager

� Starting Sprint Connection Manager

� Starting Sprint Connection Manager Automatically

� Sprint Connection Manager Window

� Connection States (Mobile Broadband Window)

� GPS Status (GPS Receiver Window)

� System Tray Connection States

� Determining the Type of Coverage

� Sprint Location Services

� Powering the Card On and Off

� Controlling the Sprint Connection Manager Window

� Launching a Sprint Power Vision or Sprint Vision Connection

� Viewing the Amount of Data Transferred

� Ending a Connection

� Online Help

� Displaying Your Phone Number

� Security

� Accessing Links

� Uninstalling the Sprint Connection Manager Software
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Sprint Connection Manager

Sprint Connection Manager is an application that allows you to manage and 
monitor the high-speed Sprint Power Vision (1xEV-DO) and Sprint Vision (1X) 
connections using your Windows computer. Use Sprint Connection Manager to:

� Determine your signal strength and other network connection parameters (page 45).

� Initiate data calls (page 62).

� Access Sprint Location Services (page 55).

� View call statistics (page 87) and messages (page 50).

� Customize features and options (page 77).

Starting Sprint Connection Manager

To start Sprint Connection Manager:

1. Ensure the card is inserted into your computer’s ExpressCard or PC Card slot, 
with the Sprint label facing up.

2. Double-click the program’s icon ( ) on your desktop, or, from the Start menu 
on your Windows desktop, select:
(Windows Vista or Windows XP) All Programs > Sprint > Sprint Mobile Broadband 
(Sierra).
(Windows 2000) Programs > Sprint > Sprint Mobile Broadband (Sierra).

When Sprint Connection Manager is running, it places an icon ( ) in the system 
tray, usually at the right end of the taskbar. If Sprint Location Services are 

supported and enabled, then a second icon ( ) is displayed in the system tray. 

(See page 54.)

Tip: Without running Sprint Connection Manager, you can make a data connection or, if 
your device supports GPS, use NMEA output simply by starting whatever application 
you want to use (such as your Web browser, email, or mapping application). 
Prerequisites: you must have previously selected, in Sprint Connection Manager, 
Enable Network Adapter (NDIS) (page 81) and, if using NMEA output, Auto Start GPS on 
connect (page 84). However, to make use of other features of the card, you must run 
Sprint Connection Manager.

Tip: You can also set Sprint Connection Manager to launch automatically 
whenever Windows starts. (See “Starting Sprint Connection Manager 
Automatically” on page 45.)
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Starting Sprint Connection Manager Automatically

To set Sprint Connection Manager to start automatically whenever Windows starts:

� From the General option in the “Settings” window (page 78), select 
Launch when Windows starts.

Sprint Connection Manager Window

If Sprint Location Services and the GPS Receiver window are not supported or not 
enabled (page 84), then only the Mobile Broadband window is displayed:

If Sprint Location Services and the GPS Receiver window are supported and 
enabled, then the GPS Receiver window is additionally shown below the Mobile 
Broadband window:

Note: Changes to this setting apply only after you restart Windows.

Tip: You can also set the connection to launch automatically whenever 
available. (See “GO automatically when ready” on page 81.) These settings 
provide an “always-on” connection, as long as you have network coverage.
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Mobile Broadband Window

The text and icons in the Mobile Broadband window indicate the connection state 

(page 50), and, when disconnected, whether the card is locked  or unlocked  
(page 67).

The Mobile Broadband window may display, depending on the connection state, 
some of the following icons:

CDMA network signal strength, indicated by the number of bars.

The ToolTip indicates the type of coverage you have (for example, 1X or 
1xEV-DO), and the signal strength, in dBm.

You are roaming. Roaming charges may apply.

Note: Sprint Location Services may not be available when roaming.

If this icon is flashing, you are in a non-preferred roaming area, and you 
may not be able to complete your calls.

Tip: You can change the roaming option (“Roam Mode;” for example, to 
disable roaming, select Sprint), and also enable the Roam Guard feature (from 
the Sprint Mobile Broadband “Settings” window; page 80).

1xEV-DO Rev. A transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

Exit

Establish/Show/

Menu

hide
details cancel a

MinimizeMessage area Indicator area

connection
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GPS Receiver Window

1xEV-DO Rev. 0 transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO (Rev. 0 and Rev. A) transmit/receive icon: the data connection 
is dormant. The up and down arrows are gray.

1X transmit/receive icon: a data connection is active.

The up arrow is black and animated when data is being transmitted to 
the network.

The down arrow is black and animated when data is being received 
from the network.

1X transmit/receive icon: the data connection is dormant. The up and 
down arrows are gray.

Exit

Start/end
Show/

Menu

hide
details NMEA output

MinimizeMessage area Indicator area

Location
information
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The text and icons in the GPS Receiver window indicate the following (described in 
the table that follows):

� GPS status

� GPS/Privacy status

� Satellite status

� Location information (when the GPS Receiver window is expanded)

The GPS Receiver window may display, depending on the GPS/Privacy status and 
satellite status, some of the following icons and text. The icons’ ToolTips in 
Sprint Connection Manager provides more information.

Privacy is on (you have not accepted the Privacy Consent Agreement). 
Sprint Location Services are not available.

To use Sprint Location Services, in the Sprint Location Services 
“Settings” window, select Enable Location Services.

Privacy is off. GPS is available. For the status of GPS, see the satellite 
status icon (described below).

GPS is available, but off. The satellite and the vertical bars are not 
colored.

To use GPS, click the GO button in the GPS Receiver window.

GPS is on, but not usable (searching for satellites). The vertical bars are 
not colored.

The ToolTip indicates the number of satellites.

GPS is on and is usable, but with lower accuracy. The vertical bars are 
colored.

The ToolTip indicates the number of satellites acquired.

GPS is on and is usable, with better accuracy. The vertical bars are 
colored.

The ToolTip indicates the number of satellites acquired.

Latitude Latitude, in decimal degrees. For example, -17.123°

Longitude Longitude, in decimal degrees. For example, 23.023°

HEPE Accuracy (horizontal/vertical precision), in feet.

Speed Current speed, in miles per hour.
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Common items

Sprint Connection Manager may display, depending on the settings of your card, 
the following buttons and text:

� Menu or the  button — Displays the Sprint Connection Manager menu 
(page 73).

�  (upper right corner of the window) — Minimizes Sprint Connection Manager 
(page 61).

�  — Exits Sprint Connection Manager (page 61).

�  (Mobile Broadband window) — Expands the Mobile Broadband window 
(page 58) and displays the amount of data transferred (when Connected), or, 

when disconnected, the lock status of your card (locked  or unlocked ).

�  (Displayed when the Mobile Broadband window is expanded) — Hides the 
amount of data transferred and the lock status of your card (page 58).

� GO (Mobile Broadband window) — Starts the Sprint Power Vision or 
Sprint Vision connection (page 62).

� Stop (Mobile Broadband window) — Ends the data connection (visible when a 
connection is established; page 66); also ends the NMEA output.

�  (GPS Receiver window) — Expands the GPS Receiver window (page 58) and 
displays location information.

�  (Displayed when the GPS Receiver window is expanded) — Hides the 
location information.

Satellites Number of satellites used in the current GPS fix.

Altitude Altitude, in feet.

Last fix Date/time that the GPS values were last acquired.

GPS Port The current NMEA port. (For information on NMEA, see “What is 
NMEA?” on page 99.)

This information is useful when configuring a GPS application to use 
your GPS-capable device (page 99).

Heading Current direction, in degrees.
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� GO (GPS Receiver window) — Starts the NMEA output (page 100).

� Stop (GPS Receiver window) — Ends the NMEA output.

Connection States (Mobile Broadband Window)

The Mobile Broadband window can display various connection and interaction 
states, including:

� No device

� Initializing

� Updating User Profile… (See “Data Provisioning [IOTA]” on page 35.)

� Searching for service...

� Disconnected

� Connecting

� Connected

� Connected to NDIS

� Device locked

� Device powered off

No device

Sprint Connection Manager did not detect the card. The GO button is unavailable.

Insert the card. If it is already inserted, remove and reinsert it; wait a few 
moments. If this message is still displayed, uninstall (page 71) and reinstall 
Sprint Connection Manager, or contact Sprint (page 14).

Initializing

Sprint Connection Manager is attempting to establish communication with the 
card.

Note: The system tray icon also indicates the connection state (page 43).
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Searching for service...

Sprint Connection Manager is determining whether 1X or 1xEV-DO service is 
available. If this message persists, see page 104.

Disconnected

Sprint Connection Manager is ready to make a connection to the network or to 
use Sprint Location Services. The GO button is available; the signal strength icon 

( ) and the roaming icon ( ) (if you’re roaming) are visible. If the Mobile 

Broadband window is expanded, the lock icon (  or ) is visible.

To connect to the network, click the GO button.

Connecting

Sprint Connection Manager is establishing a connection to the network.

Connected

The connection is established. In addition to the signal strength icon ( ) and the 

roaming icon ( ) (if you’re roaming), the transmit/receive icon (  for 1xEV-DO 

Rev. A;  for 1xEV-DO Rev. 0;  for 1X) is also displayed.

If you expand the Mobile Broadband window ( ), the amount of data transferred 
is shown. (See note on page 65.)
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To end the connection, click Stop.

Connected to NDIS

This message applies only if Enable Network Adapter (NDIS) (page 81) has been 
selected. For a description, see “Connected” (page 51).

Device locked

The card is locked, so that others cannot use the card and your account. To use 
most of the features, you must unlock the card (page 69).

Device powered off

The card has been powered off (through Menu > Power Off Modem). To use the 
card, select Menu > Power On Modem.

For more information, see “Powering the Card On and Off” on page 57.



Section 3A: Your Card: The Basics (Windows)      53

GPS Status (GPS Receiver Window)

The GPS Receiver window displays the GPS status:

� OFF

� Validating

� Searching

� Acquired

OFF

GPS is not available or is turned off.

To use GPS:

1. Ensure the card is turned on and the GPS Receiver window is  displayed.

� If the GPS Receiver window is not displayed, in Sprint Connection Manager 
select MENU > Settings > Sprint Location Services, and then select Enable Location 
Services and Display GPS Receiver. (If Privacy Consent Agreements are 
displayed, you must read and accept them.)

2. Click the GO button in the GPS Receiver window.

If the GPS Receiver window still displays “OFF,” ensure Network Mode (page 81) is 
set to Automatic or 1X Only, and (subject to change) ensure that you are in the 
network coverage area (not roaming).

Validating

The network is authenticating your wireless or GPS subscription.

Searching

Sprint Connection Manager is searching for satellites.

Acquired

Satellites have been acquired and location coordinates are available for use (and 
displayed in the GPS Receiver window [page 48]).

NMEA output is being generated. (For information on NMEA, see “What is NMEA?” 
on page 99.)

Tip: You can turn off the display of the Privacy Consent Agreements (from the Sprint 
Location Services “Settings” window; page 83).
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System Tray Connection States

Sprint Connection Manager has an associated icon ( ) that appears in the 
system tray. The icon reflects the connection state.

Clicking the system tray icon toggles between displaying and minimizing 
Sprint Connection Manager.

Right-clicking the icon displays the shortcut menu (page 75).

If Sprint Location Services are supported and enabled, then a second icon ( ) is 
displayed in the system tray. The ToolTip indicates GPS and satellite status.

Sprint Connection Manager is not ready to connect to the network. 
Your card is either locked (“Device locked”; page 52), not detected 
(“No device”; page 50), or powered off (“Device powered off”; 
page 52).

Disconnected — Sprint Connection Manager is ready to make a 
connection to the network (page 51), or
Connecting — Sprint Connection Manager is making a connection 
to the network (page 51).

Connected — Connection is established to the network; data 
transfer is in progress (page 51).

Dormant — Connection is established, but no data transfer is 
taking place.
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Determining the Type of Coverage

The ToolTip over the signal strength indicator ( ) indicates the type of coverage 
you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO):

Sprint Location Services

Sprint Location Services (Location & Search Services) allow you to query the 
network for information on points of interest that are near your current location. 
The network automatically determines your current location. All you have to do is 
specify the type of business that you are looking for (for example, a restaurant or 
hotel).

For limitations related to Sprint Location Services, see “Location-Based Services 
limitations” on page 97.

To use Sprint Location Services:

1. Ensure that, in the settings for Sprint Location Services (page 83), you have 
selected Enable Location Services and, if you will be using GPS applications, 
Display GPS Receiver, and you have accepted the Privacy Consent Agreement(s).

2. In Sprint Connection Manager, click Menu > Location & Search Services.

Tip: The type of coverage is also displayed in the lower left part of the “Device 
Info & Diagnostics” window under “Network Service” (page 90).

Note: If the menus and windows (page 55 and page 83) related to Sprint Location 
Services are unavailable in Sprint Connection Manager, see “Sprint Location 
Services Aren’t Working or Don’t Seem to Be Available” on page 105.
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If you have not made a data connection within the last 30 days, ensure you have a 
data subscription, and click Connect Now in the window that is displayed.

If the GPS fix is successful or if data from a recent GPS fix is available, then the 
“Sprint Nextel Location & Search” window is displayed. The bottom part of the 
window displays location information (latitude and longitude) of your card, and 
the time that the location information was acquired.
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3. From the “Sprint Nextel Location & Search” window, enter or select the type of 
item you want to find. If you’ve previously entered search items, a drop-down 
list displays the last five items you’ve entered. Click Go.

If more than a preconfigured period of time has elapsed since the last time you’ve 
submitted a location search, a window is displayed asking whether you want to 
get an updated (GPS) position fix. (Depending on your account, you may be 
charged for each position fix or after you have performed a certain number of 
fixes.) If your current location is different from where you submitted your last 
location search, click Yes.

Your Web browser opens and displays the results of your search query. In the 
search results of some mapping and search services, you can right-click your 
location to get additional information—for example, driving instructions.

From the “Sprint Nextel Location & Search” window, you can submit additional 
searches.

From the “Settings” window, you can specify the settings for Sprint Location 
Services (page 83).

Powering the Card On and Off

If you are using your card in an aircraft, hospital, or other environment where the 
card may cause interference, you can power the card off (without removing it from 
your computer’s slot), and still use other functions of your computer.

This also allows you to conserve your notebook computer’s battery.

To power the card off:

1. Close any active data connection (page 66).

2. Select MENU > Power Off Modem.

Note: Sprint Connection Manager uses your computer’s default Web browser to 
display the results of Sprint Location Services.
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When the card is powered off, the menu option switches to Power On Modem, the 
Mobile Broadband window displays the message “Device powered off,” and the 
GPS Receiver window displays “OFF.”

To power the card on:

� Select MENU > Power On Modem.

Controlling the Sprint Connection Manager Window

Expanding Sprint Connection Manager

The Mobile Broadband window and, if supported and enabled (page 84), the GPS 
Receiver window each have two views: compact and expanded.

To expand Sprint Connection Manager, click  in the appropriate window.

To change back to the compact view, click .
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Mobile Broadband Window

Compact view:

Expanded view:

When expanded, the Mobile Broadband window also displays the amount of data 
transferred during the current connection, and (only when disconnected) the lock 

state of the card (locked  or unlocked ).
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GPS Receiver Window

Compact view:

Expanded view:

When expanded, the GPS Receiver window displays location information 
(described in the table on page 48.)
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Minimizing Sprint Connection Manager
To save space on your screen for other programs, you can minimize Sprint Connection 
Manager:

� Click  (in the upper right corner of Sprint Connection Manager).

– or –

Click the Sprint Connection Manager icon  in the system tray.

– or –

Right-click the system tray icon and select Close Sprint Mobile Broadband.

You can use the system tray icon to monitor the connection state (page 54).

Restoring Sprint Connection Manager
To restore Sprint Connection Manager when it is minimized:

� Click the Sprint Connection Manager icon  in the system tray.

– or –

Right-click the system tray icon and select Open Sprint Mobile Broadband.

Exiting Sprint Connection Manager
To exit Sprint Connection Manager:

� In Sprint Connection Manager, select Menu > Exit, or click the  button.

– or –

Right-click the Sprint Connection Manager icon  in the system tray and 
select Exit from the shortcut menu.

If Enable Network Adapter (NDIS) (page 81) has not been selected and a connection 
is in progress, a window is displayed asking whether you want to disconnect the 
call. To end the connection and close Sprint Connection Manager, you must click 
Yes.

Tip: You can set Sprint Connection Manager to start minimized. (See “Start in 
system tray” on page 79.)

Tip: You can prevent Sprint Connection Manager being covered up by other 
windows, by setting Always on top (page 79).
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Sprint Connection Manager closes, and the Sprint Connection Manager icons 
disappear from the system tray.

Launching a Sprint Power Vision or Sprint Vision 
Connection

To launch a connection:

� Click the GO button in the Mobile Broadband window. (If the GO button is 
unavailable, see “GO Button Is Unavailable” on page 104.)

When the connection is successfully established, the network welcome screen 
appears (unless you have turned off the welcome screen display; see “Always show 
Welcome Screens” on page 81).

The Mobile Broadband window displays “Connected” or “Connected to NDIS” 
(page 51).

You can now use your Web browser, perform data transfers, and so on.

Note: If Enable Network Adapter (NDIS) (page 81) has been selected, after exiting 
Sprint Connection Manager you are still connected to the network (data 
may still be transferred). To manage the connection, use the Windows 
network connection icon in the system tray.

Note: A connection is automatically established if you select Menu > 
Location & Search Services or click the GO button in the GPS Receiver 
window.
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The connection is “active” when data transmission is occurring. If data 
transmission stops for a period of time (determined by the network), the 
connection becomes “dormant.” When you resume data traffic, the connection 
becomes active.

To monitor the status of the connection, you can use the text (page 50) and icons 
(page 45) in the Mobile Broadband window, and the icon in the system tray 
(page 54). You can also view the amount of data transferred (page 65).

Roam Guard

The Roam Guard feature, when enabled, displays a warning message if you are 
roaming and a data connection is established or about to be established. The 
message reminds you that roaming rates may apply.

Tip: You can optionally specify which application to automatically launch 
when the connection is established. (See “Auto-launch upon Network 
Connection” on page 64.)
You can also set the connection to launch automatically whenever 
available. (See “GO automatically when ready” on page 81.) If the 
connection is lost, it is restarted automatically. If you also set Sprint 
Connection Manager to launch automatically (see “Launch when Windows 
starts” on page 79), this can provide an “always-on” connection, as long as 
you have network coverage.
You can have a connection established automatically—without running 
Sprint Connection Manager—simply by starting whatever application you 
want to use (such as your Web browser or email application). Select Enable 
Network Adapter (NDIS) (page 81). However, Sprint Connection Manager 
and its icon in the system tray won’t be available for you to monitor the 
status of the connection.
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From the warning message window, you can:

� Turn off the warning message for this data session only (“Do not ask again 
during this data session.”).

� Continue with the data connection (“Roam”), in which case you may be subject 
to roaming rates.

� End the data connection (“Cancel”).

To turn on the Roam Guard feature:

1. From the Sprint Mobile Broadband option in the “Settings” window, ensure 
Roam Mode is set to Automatic.

2. From the Roam Guard drop-down list, select Always Ask.

To permanently turn off the Roam Guard feature:

� From the Roam Guard drop-down list, select Never Ask.

Auto-launch upon Network Connection

You can optionally specify which application to automatically launch when a 
Sprint Power Vision or Sprint Vision connection is established.

To specify which application to automatically launch:

1. Ensure Sprint Connection Manager is running and not locked (page 68).

2. Ensure that your card is not powered off (page 52).

3. Select MENU > Settings > Sprint Mobile Broadband - Sierra Wireless.

4. Select Auto Launch.

5. In the “Auto-Launch Options” window, select one of the following:

� None — Do not auto-launch any application.

� Website — Auto-launch Internet Explorer. In the URL field, specify the Web 
site (such as http://www.sierrawireless.com) you want to view on 
connection.

� Microsoft VPN (PPTP) Connection — Auto-launch a Windows VPN connection. 
Type in the address of the VPN connection, or select the VPN connection 
from the drop-down list.

� Application (VPN client, etc.) — Auto-launch an installed VPN program, or any 
other program. Enter the program path in the field, or use the Browse 
button to locate the program.

Note: This feature is available only if Roam Mode is set to Automatic (from the 
Sprint Mobile Broadband option in the “Settings” window; page 80).
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The changes are applied the next time you launch a connection.

Viewing the Amount of Data Transferred

To view the number of bytes sent and received during the current connection:

� If the Mobile Broadband window is not expanded, click the  button.

The number of bytes sent and received during the current connection is displayed 
to three significant digits (for example, 581 kb, 1.23 Mb, or 1.81 Mb).

Once you end the connection, all numbers reset to zero.

To hide this information, click the  button in the Mobile Broadband window.

Note: This feature functions only when Sprint Connection Manager is running.

Note: Even though the number of bytes sent and received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.
If Enable Network Adapter (NDIS) (page 81) has been selected, after exiting 
Sprint Connection Manager you are still connected to the network. Data 
may still be transferred.
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Ending a Connection

To end a connection:

� In the Mobile Broadband window, click Stop.

This ends your data connection, and also your GPS connection, if it is open.

If Enable Network Adapter (NDIS) (page 81) has not been selected and you exit 
Sprint Connection Manager while a connection is in progress, a window opens 
asking whether you want to disconnect the call. Click Yes to end the connection 
and exit Sprint Connection Manager. (See “Exiting Sprint Connection Manager” 
on page 61.)

If Enable Network Adapter (NDIS) has been selected, manually disconnecting will 
leave the card disconnected. It will not reconnect until you remove and reinsert 
the card.

If GO automatically when ready (page 81) has been selected, manually 
disconnecting will leave the card disconnected. It will not reconnect until one of 
the following occurs:

� You make a connection through Sprint Connection Manager

� A GPS fix is successfully acquired after you initiate Sprint Location Services 
(page 55)

� You restart Sprint Connection Manager

Online Help

Sprint Connection Manager includes extensive online help to provide operating 
hints and step-by-step instructions for getting the most from your card.

With Sprint Connection Manager running, you can access online help in several 
ways:

� Press <F1> when Sprint Connection Manager is the active window.

� From Sprint Connection Manager, select MENU > Help.

� Right-click the system tray icon ( ) and select Help.

The help file has a table of contents and an index.

Note: The Stop button in the GPS Receiver window ends only your GPS connection; data 
may still be transferred.
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Displaying Your Phone Number

You can view your phone number in the “Device Info & Diagnostics” window 
(Menu > Device Info & Diagnostics).

Security

When it is disconnected, you can lock your card so that others cannot use it to 
access your account. A four-digit lock code is needed to unlock the card.

You can set the card to lock: 

� Whenever Sprint Connection Manager is started (page 68).

– or –

� Immediately (without restarting Sprint Connection Manager) — useful if you 
are lending your card and computer or leaving your computer for a short time 
(page 68).

Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service provider. 
For assistance, contact Sprint (page 14). 

Configurations that use the Activation Wizard or IOTA set the initial lock code to 
the last four digits of your account phone number whenever a new phone number 
is activated.

After activation, you can change the lock code (page 70) from the initial value to 
any four-digit code you choose.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated. This may change a custom value you 
have set.
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When the Card Is Locked

When the card is locked, you can:

� Unlock the card (page 69).

� Power off the card (page 57).

When the card is locked, you cannot:

� Make data connections (the GO button is unavailable).

� Use Sprint Location Services.

� Run the Activation Wizard.

Locking the Card

To lock the card immediately: 

1. End any active connection. (You can lock the card only when it is disconnected; 
page 51.)

2. If the Mobile Broadband window is not expanded, click  to expand it.

3. Click the  icon.

4. In the “Enter User Lock Code” window, enter the lock code, and click OK.

When the card is locked, the Mobile Broadband window displays “Device locked,” 

and the lock icon is now . The GO button is unavailable.

Locking upon Sprint Connection Manager Startup
To set the card to lock as soon as Sprint Connection Manager starts up: 

1. End any active connection. (You can lock the card only when disconnected; see 
page 51.)

2. If the Mobile Broadband window is not expanded, click  to expand it.

3. Click the lock icon (  or , depending on the current lock status).

Warning: If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.

Tip: You can also set the card to be locked upon startup of Sprint Connection 
Manager, as described next.
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4. In the “Enter User Lock Code” window, enter the lock code, and select Relock 
modem when program exits.

5. Click OK.

Unlocking the Card

When the card is locked, the Mobile Broadband window displays “Device locked,” 

and the lock icon is .

To unlock the card: 

1. If the Mobile Broadband window is not expanded, click  to expand it.

2. Click the  icon.

3. In the “Enter User Lock Code” window, enter the lock code, and click OK.

When the card is unlocked, the Mobile Broadband window no longer displays 

“Device locked,” and the lock icon is .

Note: This setting takes effect only after you exit and restart Sprint Connection 
Manager.
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Changing the Lock Code

To change the lock code:

1. In the Sprint Mobile Broadband “Settings” window (page 80), click 
User Lock Change.

The “Change User Lock Code” window is displayed:

2. Enter the current lock code.

3. Enter a new four-digit lock code.

4. Enter the new lock code for confirmation.

5. Click OK.

Accessing Links

For your convenience, Sprint Connection Manager includes links to Sprint 
products and services. To access these links:

1. In Sprint Connection Manager, click Menu.

2. Select Links.

Warning:  If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.

Note: You cannot add or remove links from the Links menu. To add or remove 
links, use your Web browser.
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Uninstalling the Sprint Connection Manager Software

To remove the Sprint Connection Manager software from your computer, use the 
Add/Remove Programs utility built into your Windows operating system.

1. Exit Sprint Connection Manager (page 61).

2. Remove the card. (See “Removing the Card (Windows)” on page 28.)

3. Select Start > Control Panel and select:

(Windows Vista) Programs and Features.
(Windows XP or Windows 2000) Add/Remove Programs.

The Windows Add/Remove Programs utility will start. Be sure the Change or 
Remove Programs feature is selected (default).

4. From the list, select Sprint Mobile Broadband (Sierra), and click Remove or 
Uninstall.
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Sec tion 3B

Menu Options (Windows)

In This Section

� Sprint Connection Manager Menu

� System Tray Menu

This chapter describes each menu option you may encounter while using your 
card and the Sprint Connection Manager software on your Windows computer.
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Sprint Connection Manager Menu

Clicking Menu or the  button, located in the upper left corner of 
Sprint Connection Manager, displays the Sprint Connection Manager menu.

The following table describes the menu options:

Note: Depending on your configuration and settings, not all menu options may be 
shown or enabled as described here.

Tip: You can also display the menu by positioning the cursor over the Menu text 
or the  button and then pressing the spacebar or Enter key on your 
keyboard. To hide the menu, press Esc, or click outside the menu.

Menu Item Description

Links  Access links to Sprint products and services. 

See “Accessing Links” on page 70.

Power Off 
Modem

Power off your card.

See “Powering the Card On and Off” on page 57.

Location & 
Search 
Services

Query the network for information on points of interest that 
are near your current location.

See “Sprint Location Services” on page 55.



74 Section 3B: Menu Options (Windows)

Alert Log View a record of all alerts (for example, connection errors) 
that have been received while establishing and maintaining 
connections. 

See “Viewing Alerts” on page 88.

Connection 
History

View a record of connections established using your card 
(unavailable if the Connection History is empty, or if Keep 
Connection History [page 79] is not selected).

See “Viewing the Connection History” on page 87.

Device Info & 
Diagnostics

View information about your card and run diagnostic tests. 

See “Running Diagnostics” on page 89.

Software 
Updates

Retrieve updates for Sprint Connection Manager and your 
card. 

See “Updating the Software” on page 91.

Help Display the online Help, which has operating hints and step-
by-step instructions for getting the most from your card. 

See “Online Help” on page 66.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere inside 
it. 

See “About Sprint Mobile Broadband” on page 92.

Settings Change the settings for Sprint Connection Manager. Contains 
submenu items:

� General: See “General Settings” on page 78.

� Sprint Mobile Broadband - Sierra Wireless: See “Sprint Mobile 
Broadband Settings” on page 80.

� Sprint Location Services: See “Sprint Location Services 
Settings” on page 83.

Exit  Exits Sprint Connection Manager.

Menu Item Description
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System Tray Menu

When you right-click the system tray icon ( ), a shortcut menu is displayed:

The following table describes the menu options:

Menu Item Description

Open/Close 
Sprint Mobile 
Broadband

Minimize Sprint Connection Manager (Close), or restore 
(Open) if Sprint Connection Manager is minimized.

Help Display the online Help.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere 
inside it.

Exit Exit Sprint Connection Manager.



76 Section 3C: Changing Sprint Connection Manager Settings (Windows)

Sec tion 3C

Changing Sprint Connection Manager Settings 
(Windows)

In This Section

� Settings Window

� General Settings

� Sprint Mobile Broadband Settings

� Sprint Location Services Settings

This chapter describes you can change to customize Sprint Connection Manager.
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Settings Window

From the “Settings” window, you can specify the settings for Sprint Connection 
Manager.

1. In Sprint Connection Manager, click Menu.

2. Select Settings.

3. From the drop-down list, select one of the following categories of settings:

� General (general behavior of Sprint Connection Manager; page 78)

� Sprint Mobile Broadband - Sierra Wireless (behavior of your Sprint Power 
Vision or Sprint Vision connection; page 80)

� Sprint Location Services (page 83)

4. Make the appropriate changes to the settings (described in the following 
pages).

5. To change other settings, repeat steps 3 and 4.

6. Click OK.

Note: This feature is temporarily unavailable if you have powered off the card 
(page 57).

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint Connection Manager.

Tip: You can also access the “Settings” window from the “Connection History” 
window (page 87): click File > Settings.
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General Settings

From the General option in the “Settings” window, you can specify settings that 
affect the general behavior of Sprint Connection Manager.
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The following table describes the options:

Menu Item Description

Play sound 
effects

Play a clicking sound whenever an action is made in 
Sprint Connection Manager.

Always on 
top

Keep Sprint Connection Manager visible on your screen 
regardless of which applications are open.

Start in 
system tray

Have Sprint Connection Manager start (minimized) in the system 
tray on startup. (See “Restoring Sprint Connection Manager” 
on page 61.)

Keep 
Connection 
History

Have Sprint Connection Manager keep a log of your data 
connections (page 87).

Launch when 
Windows 
starts

Have Sprint Connection Manager start automatically when 
Windows starts.

Tip: You can also set the Sprint Power Vision or Sprint Vision 
connection to launch automatically whenever available (see “GO 
automatically when ready” on page 81). These settings provide an 
“always-on” connection, as long as you have network coverage.

Check for 
updates once 
per month

Have Sprint Connection Manager automatically check for 
software updates (page 91).

Check Now Check for software updates immediately.

Note: During the software update, Sprint Connection Manager will 
close. Before you initiate the software update, finish any Web 
browsing, data transfers, and so on.

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint Connection Manager.
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Sprint Mobile Broadband Settings

From the Sprint Mobile Broadband option in the “Settings” window, you can 
change the behavior of your Sprint Power Vision or Sprint Vision connection.
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The following table describes the options:

Menu Item Description

Always show 
Welcome 
Screens

Display a welcome screen upon a successful connection to the 
network.

GO 
automatically 
when ready

Automatically connect to the network after Sprint Connection 
Manager starts, or whenever Sprint Connection Manager 
loses the network connection.

To select GO automatically when ready, ensure that Enable 
Network Adapter (NDIS) (below) is not selected.

Tip: You can also set Sprint Connection Manager to start 
automatically (see “Launch when Windows starts” on page 79). 
These settings provide an “always-on” connection, as long as you 
have network coverage.

You can have a connection established automatically, without 
having to run Sprint Connection Manager. Ensure that 
GO automatically when ready is not selected, and select Enable 
Network Adapter (NDIS) (below).

Enable 
Network 
Adapter 
(NDIS)

Make a connection automatically, without running 
Sprint Connection Manager—simply by starting whatever 
application you want to use (such as your Web browser or 
email application).

To select Enable Network Adapter (NDIS), ensure that GO 
automatically when ready (above) is not selected.

Network 
Mode: 
Automatic

Attempt a Sprint Power Vision (1xEV-DO) connection and, if 
not successful, attempt the slower Sprint Vision (1X) 
connection.

Network 
Mode: 
1xEV-DO 
Only

Attempt only a Sprint Power Vision (1xEV-DO) connection.

Note: Sprint Location Services may not be supported. When in an 
area that has only Sprint Vision (1X) coverage, you won’t be able to 
connect to the network.

Network 
Mode: 
1X Only

Attempt only a Sprint Vision (1X) connection (even when you 
have Sprint Power Vision [1xEV-DO] coverage, which provides 
faster data transmission speeds).

Note: When in an area that has only Sprint Power Vision (1xEV-DO) 
coverage, you won’t be able to connect to the network.
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Roam Mode: 
Sprint

Disable roaming when you are not in the network coverage 
area. You will be able to connect only when you are in the 
network coverage area.

Roam Mode: 
Automatic

Allow roaming when you are not in the network coverage 
area.

Note: Roaming rates may apply. Roam Guard (page 63) can remind 
you of this.

Roam Mode: 
Roam Only

Allow only roaming.

Note: Roaming rates may apply. Roam Guard (page 63) can remind 
you of this. Sprint Location Services may not be available.

Roam Mode: 
Roam Guard

Display a warning message when you are about to establish a 
data connection while roaming. For more information, see 
“Roam Guard” on page 63.

Available only if Roam Mode is set to Automatic (page 82).

Note: If you proceed with the data connection, roaming rates may 
apply.

Device LED 
Enabled

Enable or disable the LED of your card.

For a description of the LED states, see “LED Operation” on 
page 136.

Activation 
Wizard

Used only when activating a card, or when changing your 
card’s phone number (page 33).

User Lock 
Change

Change the security lock code of the card (page 70).

Auto Launch Optionally specify which application to automatically launch 
when a connection is established.

See “Auto-launch upon Network Connection” on page 64.

Menu Item Description
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Sprint Location Services Settings

From the Sprint Location Services option in the “Settings” window, you can change 
the behavior of Sprint Location Services. (For more information on Sprint Location 
Services, see page 55.)
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The following table describes the options:

Menu Item Description

Enable 
Location 
Services

Turn on support (by your card) for Sprint Location Services.

Note: To use Sprint Location Services, your account must also be 
configured appropriately. If you are unable to use Sprint Location 
Services, see “Sprint Location Services Aren’t Working or Don’t Seem to 
Be Available” on page 105 or contact Sprint Customer Service 
(page 14).

Display GPS 
Receiver

Show or hide the GPS Receiver window (page 58).

Display GPS 
Welcome

Display a welcome window whenever you initiate 
Sprint Location Services.

Auto Start 
GPS on 
connect

Start an NMEA output stream whenever your card connects to 
the network. (For more information on NMEA, see “What is 
NMEA?” on page 99 and “When do I need to use NMEA?” on 
page 99.)

For this option to have effect, either Enable Network Adapter 
(NDIS) (page 81) must be selected, or Launch when Windows 
starts (page 79) and GO automatically when ready (page 81) 
must be selected.

Note: Use this option only if you're using NMEA output all the time. This 
option results in slower device data performance.

Display 
'Location & 
Search 
Services' on 
the menu

Show or hide the Sprint Connection Manager menu item that 
displays the “Sprint Nextel Location & Search” window. For 
more information on this window, see “Sprint Location 
Services” on page 55.

Do not show 
NMEA Privacy 
Consent

Prevent a “Privacy Consent Agreement” window from 
appearing every time you use NMEA. For more information, 
see “What is NMEA?” on page 99 and “When do I need to use 
NMEA?” on page 99.
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Do not show 
Privacy 
Consent for 
'Location & 
Search 
Services'

Prevent a “Privacy Consent Agreement” window from 
appearing every time you use the Location & Search Services 
menu.

Microsoft Live

MapQuest

Yahoo! Maps

Google Maps

Specify which mapping and search service (for example, 
Microsoft® Live, or Google™ Maps) your Web browser uses for 
Sprint Location Services.

Some mapping and search services may have data that is 
more current or accurate than that of other mapping and 
search services.

Test GPS Verify that your card is able to obtain data for Sprint Location 
Services:

1. Ensure that Network Mode (from the Sprint Mobile 
Broadband “Settings” window; page 80) is set to 
Automatic or 1X Only. (Sprint Location Services may not be 
available if Network Mode is set to 1xEV-DO Only.)

2. Ensure you are in the network coverage area (not 
roaming).

3. Click Test GPS.

The results (including the number of satellites, latitude, 
longitude, and elevation information) are displayed to the 
right of the Test GPS button.

Menu Item Description
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Section 3D

Tools (Windows)

In This Section

� Viewing the Connection History

� Viewing Alerts

� Running Diagnostics

� Updating the Software

� About Sprint Mobile Broadband

This chapter describes various features you can use to view information about the 
card and the Sprint Connection Manager software on your Windows computer.
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Viewing the Connection History

Connection History displays a record of connections established using your card. 
You can sort records by connection name to easily distinguish between personal 
and business usage.

From this window you can also access the “Settings” window (page 77) (File > 
Settings).

To view the Connection History:

1. In Sprint Connection Manager, click Menu.

2. Select Connection History.

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.)

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

Note: For connections to be recorded, Keep Connection History must be enabled 
(page 79).
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To copy one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries; to select all entries, select Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

To delete all entries:

� Click the Clear button.

To delete one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries.)

2. Select Edit > Delete.

Viewing Alerts

The Alert Log displays a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining connections. You can use 
the Alert Log to help isolate and resolve connection issues.

To view the Alert Log:

1. In Sprint Connection Manager, click Menu.

2. Select Alert Log. (This menu option is unavailable if the alert log is empty.)

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.) 

– or –

Click an option under the Sort menu.
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To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

To copy one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries; to select all entries, select Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

To delete all entries:

� Click the Clear button.

To delete one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries.)

2. Select Edit > Delete.

Running Diagnostics

To identify problems when connecting to the network, use the “Device 
Info & Diagnostics” window. Device Info & Diagnostics evaluates issues with your 
USB port, port configuration, network signal strength, Sprint Connection 
Manager, and more. Once the program runs a diagnostics check, it recommends 
solutions.

The program also displays information such as your phone number.

Results of the diagnostics can be shared with a Sprint Customer Service Specialist, 
to assist that person with troubleshooting.

To access the “Device Info & Diagnostics” window:

1. Ensure the card is inserted.

2. In Sprint Connection Manager, click Menu.

3. Select Device Info & Diagnostics.
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The tests automatically start when the window opens.

From the “Device Info & Diagnostics” window, you can view system information 
(page 91) and save the system information to an RTF (Rich Text Format) file.

From the “Device Info & Diagnostics” window, you can also update parameters in 
your card:

� Click Update Data Profile. (If this button is not displayed, remove and reinsert 
the card.)
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Displaying System Information

The “System Information” window displays:

� System Parameters: Information about your computer hardware and software.

� Installed Files: Files related to Sprint Connection Manager.

� Device Info & Diagnostics: Information about the card (including its phone 
number), and results of various tests.

To display system information:

1. Select Menu > Device Info & Diagnostics.

2. In the “Device Info & Diagnostics” window, click System Information.

To save the information to a file (for example, if you are requested to send the report to 
your service provider representative):

1. In the “System Information” window, click Create Report.

2. Specify a file name and path.

3. Click Save.

Updating the Software

From time to time, Sprint may release updates for Sprint Connection Manager and 
your card. These updates may add features or improve network performance.

To update the software:

1. Ensure you have a network connection.

2. In Sprint Connection Manager, click Menu. Select Software Updates. 

– or –

From the General option in the “Settings” window (page 77), click Check Now.

You can also set the software to automatically check for updates once a month:

1. In Sprint Connection Manager, click Menu and then select Settings.

2. Select Check for updates once per month.

Note: During the software update, Sprint Connection Manager will close. Before 
you initiate the software update, finish any Web browsing, data transfers, 
and so on.
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About Sprint Mobile Broadband

The “About Sprint Mobile Broadband” window displays information about the 
Sprint Connection Manager software.

To display this window:

� In Sprint Connection Manager, click Menu and then select About Sprint Mobile 
Broadband. 

– or –

Right-click the Sprint Connection Manager icon ( ) in the system tray and, 
from the shortcut menu, select About Sprint Mobile Broadband.

To close this window, click anywhere inside it.

Tip: To display more information, you can run diagnostics (page 89).
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Sec tion 3E

Frequently Asked Questions (Windows)

In This Section

� Questions about My Account

� Questions about Sprint Connection Manager

� Questions about GPS and Sprint Location Services

� Other Questions
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Questions about My Account

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

Questions about Sprint Connection Manager

What is Sprint Connection Manager?

Sprint Connection Manager is software that lets you connect to the Sprint Power 
Vision or Sprint Vision network. Sprint Connection Manager takes advantage of 
the increased data speeds offered by the Sprint Mobile Broadband Network.

How fast is the connection with Sprint Connection Manager?

The Sprint Mobile Broadband Network allows you to connect to the Internet at 
speeds of up to 3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps 
(1X). Average connection speeds are:

� For 1xEV-DO Rev. A: between 600 kbps and 1.4 Mbps downlink from the 
network, and between 350 and 500 kbps uplink to the network;

� For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, 
and between 40 and 80 kbps uplink to the network;

� For 1X: between 40 and 80 kbps.

These speeds are faster than dial-up connection speeds.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.

Questions about GPS and Sprint Location Services

What is LBS?

LBS (Location-Based Services) is used to provide enhanced Local Search 
functionality via internet mapping services. For more information, see “What is 
enhanced Local Search?” on page 95.
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What is GPS?

GPS stands for Global Positioning System, which is a system that uses a series 
of 24 geosynchronous satellites to provide location data.

GPS satellites transmit signals to equipment on the ground. GPS receivers 
passively receive satellite signals, but do not transmit.

Various GPS standards exist for the User Plane and Control Plane. For more 
information, see “What is GPS User Plane?” and “What is GPS Control Plane?” on 
page 96.

What is enhanced Local Search?

Enhanced Local Search is a quick, easy method to run, via Sprint Connection 
Manager, local search queries to find locations and directions to locations and 
businesses.

The enhanced Local Search feature uses LBS and allows you to search for Sprint 
Nextel stores, restaurants, banks, hotels, and so on, outdoors and (with GPS 
Premium) indoors. For more information, see “What is GPS Premium?” on page 98.

How do I get the enhanced Local Search feature?

The enhanced Local Search feature works only with GPS-capable data cards and 
the latest version of Sprint Connection Manager. The feature is available at no 
additional charge in the latest version of Sprint Connection Manager.

Where do I find the enhanced Local Search feature?

In Sprint Connection Manager, select Menu > Location & Search Services.

How do I use the enhanced Local Search feature?

When running Sprint Connection Manager, select Menu > Location & Search 
Services. Some predefined, most frequently used queries are listed. There is also an 
option to run your own custom query; if you've previously entered search items, a 
drop-down list displays the last five items you've entered.

Note: Sprint Location Services may not be supported if Network Mode is set to 1xEV-DO Only. 
To use Sprint Location Services, ensure Network Mode is set to Automatic or 1XOnly.
Sprint Location Services are not supported if you're roaming (subject to change).
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Where can I use GPS?

GPS works wherever there is both Sprint CDMA network access and GPS access.

What is GPS User Plane?

GPS User Plane is the ability to execute GPS requests at the subscriber level on the 
card. In other words, the User Plane allows you to submit location-related queries 
to the network.

Compare to GPS Control Plane (see below).

What is GPS Control Plane?

GPS Control Plane is the ability to execute GPS requests at the network (server) 
level.

Compare to GPS User Plane (see above).

How do I enable/disable GPS?

By default, Sprint Location Services are disabled.

To enable Sprint Location Services:

1. In the Sprint Location Services “Settings” window, select Enable Location 
Services.

2. If you will be using the GPS Receiver window (page 47), select Display GPS 
Receiver.

Will GPS work when Privacy is set to ON?

No. Setting Privacy to ON [by not accepting the Consent Privacy Agreement(s)] 
means you do not want your card to be discoverable; thus, GPS is not enabled/
started on the card.

Note: Your card or account may not support GPS.
In some locations where CDMA network access is available, GPS may not 
be available at this time. For the latest on service available by location, refer 
to Sprint Nextel Coverage maps.
If you’re having problems using GPS, contact Sprint.

Tip: To prevent Privacy Consent Agreements from appearing every time you use NMEA or 
the Location & Search Services menu, select Do not show NMEA Privacy Consent and Do 
not show Privacy Consent for 'Location & Search Services'.

Tip: An icon in the GPS Receiver window indicates the GPS/Privacy status (page 48).
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Can I use Sprint Location Services if I have enabled NDIS?

Yes. Sprint Location Services/GPS services are supported, whether or not you have 
selected Enable Network Adapter (NDIS).

Do I need a GPS subscription to use GPS?

For GPS Basic, you do not need a GPS subscription.

For GPS Premium, you need a GPS subscription.

For more information on GPS Basic and GPS Premium, see “What is GPS Basic?” 
and “What is GPS Premium?” on page 98.

Location-Based Services limitations

To acquire a location fix, you must be connected to the Sprint network, (subject to 
change) not roaming, and, for the initial fix, in 1X coverage.

Weather conditions may affect your ability to get a clear view of the satellites and 
thus to acquire a GPS fix.

If you're outside with a clear view of the sky, the card uses MS-Based position 
location technology. MS-Based GPS (Basic) is for outdoor use only. If the MS-Based 
location fix fails, then a standalone location fix is attempted, and a window is 
displayed (to turn off this window, select Do not ask me again).

Note: Location-Based Services use Advanced Forward Link Trilateration (AFLT). AFLT is a type 
of device-based position location technology. Unlike A-GPS, AFLT does not use GPS 
satellites to determine location. Instead, the device takes measurements of signals 
from nearby cellular base stations (towers) and reports the time/distance readings 
back to the network; the readings are then used to triangulate an approximate 
location of the device. In general, at least three surrounding base stations are 
required to get an optimal position fix.
AFLT accuracy may vary, depending on the geometry of the cell towers in your 
location.
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What GPS mode options are supported?

GPS on a Sprint data card works like any other GPS device. Sprint provides two 
types of GPS mode: GPS Basic, and GPS Premium.

For more information, see “What is GPS Basic?” and “What is GPS Premium?” on 
page 98.

What is GPS Basic?

Sprint GPS Basic supports GPS outdoors. Your card requires an unobstructed view 
of GPS satellites (in the sky), and, like any other GPS device, might not perform 
well within forested areas or near tall buildings. 

Sprint GPS Basic is based on GPSOne™ standards and uses Location-Based Services 
for the first, fast, GPS fix. GPS coordinate values are made available to applications 
via a local GPS NMEA Com port.

See also “What is NMEA?” on page 99 and “What is the difference between GPS 
Basic and GPS Premium?” on page 98.

What is GPS Premium?

GPS Premium supports GPS outdoors (as does GPS Basic) and additionally indoors 
(where no GPS satellites are available).

To use GPS Premium, you need a GPS subscription.

What is the difference between GPS Basic and GPS Premium?

GPS Basic is for outdoor use — similar to the capability of a regular GPS device.

GPS Premium is an enhanced GPS capability that allows GPS to be used indoors 
and outdoors. To use GPS Premium, you need a GPS subscription.

Note: Sprint Location Services may not be supported if Network Mode is set to 1xEV-DO Only 
or (subject to change) if you are roaming. To use Sprint Location Services, ensure 
Network Mode is set to Automatic or 1XOnly, and ensure that you are in the network 
coverage area (not roaming).

Note: At the time of this software release, this GPS mode option is not yet available.
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What is a GPS application?

A GPS application is an application that uses NMEA data to get regular location 
coordinate updates and values typically displayed in an application. (For more 
information on NMEA, see “What is NMEA?” [below].)

Examples of GPS applications are Microsoft Streets & Trips, and Microsoft 
MapPoint.

What is NMEA?

NMEA stands for “National Marine Electronics Association.”

NMEA 0183 is a standard protocol used by GPS devices to send and receive data.

NMEA output is composed of various strings. Sprint GPS data cards support the 
following strings:

� $GPGGA

� $GPRMC

� $GPGSA

� $GPGSV

See also “When do I need to use NMEA?”, “How do I start and stop NMEA?”, and 
“How do I configure my NMEA port?”, starting on page 99.

How do I configure a GPS application to use my GPS-capable 
device?
To configure a GPS application to use your GPS-capable device:

1. Start GPS NMEA (page 100).

2. Note the “GPS Port” value displayed in the expanded GPS Receiver window 
(page 47).

3. Configure your GPS application to use the same port. For help, see the 
documentation of the GPS application.

When do I need to use NMEA?

You need to use NMEA only when using a GPS application that uses an NMEA 
output stream. For more information, see “What is a GPS application?” on page 99 
and “How do I start and stop NMEA?” on page 100.

Note: To ensure the best data performance of your card, it’s recommended that you not 
activate the NMEA stream unless you are going to use it.
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How do I start and stop NMEA?

To start NMEA output:

1. Click the GO button in the GPS Receiver window (page 47).

2. Read and accept the Privacy Consent Agreement.

To stop NMEA output, you have several options:

� In the GPS Receiver window, click Stop.

� In the Mobile Broadband window, click Stop.

� Exit Sprint Connection Manager.

� If you have started the GPS application before you started NMEA output: exit 
the GPS application.

How do I configure my NMEA port?

At the time of this software release, you cannot specify which port Windows uses 
for NMEA output. Windows automatically uses the next available port.

You can, however, configure the GPS application to use the NMEA Com port that 
Windows is using (page 99).

Other Questions

Once I connect to the network, how do I access my corporate 
network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate user name and 
password to gain access. For support, contact your company help desk.

Note: To ensure the best data performance of your card, it’s recommended that you not 
activate the NMEA stream unless you are going to use it.

Tip: You can turn off the display of the NMEA Privacy Consent Agreement (from the 
Sprint Location Services “Settings” window).
You can also set your card to start an NMEA output stream whenever the card 
connects to the network (Auto Start GPS on connect; page 84).
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How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

Ensure Auto Start GPS on connect (page 84) is not enabled.

Depending on your corporate email client, you can optimize your settings by doing 
the following:

� Work in “offline” mode, and connect only when you need to send or receive 
email.

� Remove the Preview Pane, or use the AutoPreview for headers only.

� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, see the user documentation of your email client.

Why won’t my laptop go into hibernation mode when using my 
Sprint Mobile Broadband card?

If you’re using Windows 2000, you need to upgrade to Service Pack 4 from 
www.microsoft.com.

http://www.microsoft.com
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Sec tion 3F

Troubleshooting Tips (Windows)

In This Section

� Problems, Causes, and Solutions

� GO Button Is Unavailable

� Searching for Service

� Cannot Connect to the Network

� Sprint Location Services Aren’t Working or Don’t Seem to Be Available

� Could Not Prepare Data Services

� Unable to Prepare Data Services

� Sprint Connection Manager Stops Working After Upgrading Windows

This section helps you diagnose and solve common problems you may experience 
while using your Sprint Mobile Broadband card and the Sprint Connection 
Manager software on a Windows computer.
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Problems, Causes, and Solutions

When properly installed, the Sprint Mobile Broadband card is a highly reliable 
product.

Most problems are caused by one of these issues:

� Network coverage is not available (because of your “Network Mode” settings 
[page 80], or because you are outside the network, or because of an account or 
network problem).

� The drivers were not properly installed because of a problem with your 
computer’s ExpressCard slot, PC Card slot, or with the ExpressCard to PC Card 
adapter.

� System resources required by the card are being used by other devices.

Tips when troubleshooting problems with your card and software:

� Ensure your card is inserted, not locked (page 68), and not powered off 
(page 52).

� If the data performance of your card is not optimal, ensure Auto Start GPS on 
connect (page 84) is not enabled.

� Check the status of the LEDs; to interpret their status, see “LED Operation” on 
page 136. If the LEDs are not lit, ensure that Device LED Enabled (page 82) is 
selected.

� To determine the connection status, use the icons in the system tray (page 54), 
and icons in the Mobile Broadband window (page 46) and GPS Receiver window 
(page 48), and messages in the Mobile Broadband window (page 50) and GPS 
Receiver window (page 53).

� The alert log might indicate the nature of the problem (page 88).

� Run diagnostic tools supplied with Sprint Connection Manager (page 89).

� Check the Frequently Asked Questions (Windows) (page 93).

� Use the resources listed in “Getting Help” (page 13).

� If Sprint Connection Manager stopped working after you’ve upgraded to a 
different version of Windows, see “Sprint Connection Manager Stops Working 
After Upgrading Windows” on page 107.

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com or contact Sprint Customer Service. (See “Getting Help” on 
page 13.)

http://www.sprint.com
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GO Button Is Unavailable

Ensure the card is properly inserted, not locked (page 68), and not powered off 
(page 52).

If the Mobile Broadband window displays “Searching for service” for a long period 
of time (for example, several minutes), see “Searching for Service” below.

If Roam Mode is set to Sprint, ensure you are in the network coverage area (not 
roaming), or change the setting (page 82). (You may be subject to roaming rates.)

Searching for Service

If the Mobile Broadband window displays “Searching for service” for a long period 
of time (for example, several minutes), try one of the following: 

� Try reorienting your computer.

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� If Roam Mode is set to Sprint, ensure you are within the network coverage area, 
or change the Roam Mode setting. (You may be subject to roaming rates.)

� If Roam Mode is set to Roam Only, ensure you are roaming, or change the 
Roam Mode setting.

� If Network Mode is set to 1X Only, and only 1xEV-DO coverage is available, either 
move to an area that has 1X coverage, or change the setting to Automatic or 
1xEV-DO Only. Note: With the setting 1xEV-DO Only, Sprint Location Services 
may not be supported.

� If Network Mode is set to 1xEV-DO Only, and only 1X coverage is available, either 
move to an area that has 1xEV-DO coverage, or change the setting to Automatic 
or 1X Only.

� Check with Sprint — a network or account problem may be preventing the card 
from obtaining service.
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Cannot Connect to the Network

If you’re having problems connecting, or there’s no Sprint Power Vision (1x-EVDO) 
coverage in your area, set Network Mode to 1X Only and try to establish a 
connection.

If the connection is dropped as soon as it is established:

1. Select:

(Windows Vista) Start > Control Panel > Network and Sharing Center > 
Manage Network Connections
(Windows XP) Start > Control Panel > Network Connections
(Windows 2000) Start > Settings > Control Panel > Network and Dial-Up 
Connections

2. Right-click Sprint Mobile Broadband - Sierra Wireless, and select Properties.

3. Select:

(Windows Vista) Options, and select PPP Settings.
(Windows XP) Networking tab, and select Settings.

4. Ensure that “Enable LCP Extensions” is selected and “Negotiate multi-link for 
single link connections” is not selected.

5. Click OK.

Sprint Location Services Aren’t Working or Don’t Seem to Be 
Available

If Sprint Location Services aren’t working or don’t seem to be available, check 
whether you have, in the “Settings” window (page 77), a Sprint Location Services 
option in the drop-down list.

� If the drop-down list does not have the Sprint Location Services option, then 
your account, your card, or both are not configured to support Sprint Location 
Services; contact Sprint Customer Service (page 14).

– or –

1. Select the Sprint Location Services option from the drop-down list and ensure 
that Enable Location Services and Display 'Location & Search Services' on the menu 
are selected. (If a Privacy Consent Agreement is displayed, you must read and 
accept it.)
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2. If you will be using NMEA, select Display GPS Receiver. (For more information on 
NMEA, see “What is NMEA?” on page 99.)

3. Ensure that Network Mode (in the Sprint Mobile Broadband “Settings” 
window) is set to Automatic or 1X Only. (Sprint Location Services may not be 
available if Network Mode is set to 1xEV-DO Only.)

4. Ensure you are in the network coverage area (not roaming). For the initial fix, 
you must be in 1X coverage.

5. To verify that your card is able to obtain data for Sprint Location Services, in 
the Sprint Location Services “Settings” window, click Test GPS.

6. If the results show the number of satellites and valid latitude, longitude, and 
elevation information, then check that the GPS application (for example, 
street mapping application) is configured to use the correct port. (The port 
number that the GPS application should use is displayed in the GPS Receiver 
window [page 47].)

For help on checking which port the GPS application is configured to use, see 
the documentation of the GPS application.

7. If the GPS application is configured to use the correct port, but the application 
doesn’t seem to be reporting correct results, then there may be a problem 
with the GPS application.

Could Not Prepare Data Services

See “Unable to Prepare Data Services” (below).

Unable to Prepare Data Services

The card was unable to access the IOTA server to obtain data account parameters 
for you. This may be because the signal strength is poor or because the IOTA server 
is not responding.

� Confirm you have sufficient signal strength. Try the actions listed for “Searching 
for Service” (page 104).

� Contact Sprint for assistance (page 14).

Note: The message may appear as “Could not prepare data services. Please contact...”
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This message may indicate that your system does not support 128-bit encryption 
for high-security access to data provisioning. You will not be able to complete the 
activation of data services until you upgrade your system’s security. (See “High 
Encryption Requirements [Windows]” on page 10.)

Sprint Connection Manager Stops Working After 
Upgrading Windows

If you’ve upgraded Windows, and Sprint Connection Manager stopped working:

1. Uninstall Sprint Connection Manager (page 71).

2. Reinstall Sprint Connection Manager (page 17).

Note: After the following steps, any changes you made to Sprint Connection 
Manager settings will be lost; you will have to reapply the changes.
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Using the Card on a Mac

Section 4
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Sec tion 4A

Your Card: The Basics (Mac)

In This Section

� Starting Watcher Lite

� Watcher Lite Window

� Connection States

� Determining the Type of Coverage

� Powering the Card Off

� Launching a Sprint Power Vision or Sprint Vision Connection

� Viewing the Amount of Data Transferred

� Ending a Connection

� Displaying Your Phone Number and ESN

� Security

� Uninstalling the Watcher Lite Software
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Watcher Lite

Watcher Lite is an application that allows you to manage and monitor the 
high-speed Sprint Power Vision (1xEV-DO) and Sprint Vision (1X) connections on 
your Mac computer. Use Watcher Lite to:

� Determine your signal strength and other network connection parameters 
(page 111).

� Initiate data calls (page 116).

Starting Watcher Lite

To start Watcher Lite:

1. Ensure the card is inserted into your computer’s ExpressCard or PC Card slot, 
with the Sprint label facing up.

2. In Finder, choose Go > Applications > Sierra Wireless Watcher.

Watcher Lite Window

The “Sierra Wireless Watcher Lite” window may display, depending on the 
coverage and connection state, some of the following icons and text:

CDMA network signal strength, indicated by the number of bars.

You are not in a network coverage area.

You have 1X and 1xEV-DO Rev. 0 coverage.

You have 1X and 1xEV-DO Rev. A coverage.

You have 1X coverage.

Establish/
cancel a

Message area

Indicator area

connection

ResizeMinimize

Close
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Connection States

The “Watcher Lite” window can display various connection and interaction states, 
including:

� No device detected

� Not activated

� Updating User Profile…

� Disconnected

� Connecting

� Connected

� Device is Locked

No device detected

Watcher Lite did not detect the card. The Connect button is unavailable.

Insert the card. If it is already inserted, remove and reinsert it; wait a few 
moments. If this message is still displayed, uninstall (page 120) and reinstall 
Watcher Lite.

You have 1xEV-DO Rev. 0 coverage.

You have 1xEV-DO Rev. A coverage.

You are roaming. Roaming charges may apply.

You are in the network coverage area (not roaming).

Rx Amount of data received from the network.

Tx Amount of data transmitted to the network.
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Not activated

To use your card, you must activate it. Use the Activation Assistant (page 38).

Updating User Profile

Watcher Lite is performing account setup for you by making a connection to the 
CDMA network and using a secure Internet connection to download account 
parameters to your card.

Disconnected

Watcher Lite is ready to make a connection to the network. The Connect button is 

available; the signal strength icon ( ), coverage indicator ( ), and the 

roaming icon ( ) are visible.

To connect to the network, click the Connect button.
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Connecting

Watcher Lite is establishing a connection to the network.

Connected
The connection is established. In addition to the signal strength icon ( ), 

coverage indicator ( ), and roaming icon ( ), the amount of time you’ve been 
connected and the amount of data received (Rx) and transmitted (Tx) are also 
displayed. (See the note on page 117.)

To end the connection, click Disconnect.

Device is Locked

The card is locked, so that others cannot use the card and your account. To use 
most of the features, you must unlock the card (page 120).
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Determining the Type of Coverage

An icon in Watcher Lite ( ) indicates the type of coverage you have (for 
example, 1X [synonym of 1xRTT] or 1xEV-DO). See the table on page 111.

Powering the Card Off

If you are using your card in an aircraft, hospital, or other environment where the 
card may cause interference, you can power the card off (without removing it from 
your ExpressCard or PC Card slot), and still use other functions of your computer.

This also allows you to conserve your notebook computer’s battery.

To power the card off:

1. Close any active data connection (page 117).

2. From the Extras item on the Sierra Wireless Watcher menu, select Turn 
Sprint Device Off.

When the card is powered off, Watcher Lite displays the message “No device 
detected.”

To power the card on:

� Remove the card (page 30) and reinsert it.
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Exiting Watcher Lite
To exit Watcher Lite:

� Click the button in the upper left corner of the “Watcher Lite” window.

Launching a Sprint Power Vision or Sprint Vision 
Connection

To launch a connection:

� Click the Connect button in the “Watcher Lite” window. (If the Connect button 
is unavailable, see “Connect Button Is Unavailable” on page 130.)

Once you’re connected to the network, Watcher Lite displays “Connected,” the 
amount of time you’ve been connected, and the amount of data received (Rx) and 
transmitted (Tx).

You can now use your Web browser, perform data transfers, and so on.

Closes the “Watcher Lite” window
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Viewing the Amount of Data Transferred

Once you’re connected to the network, Watcher Lite shows the amount of data 
received (Rx) and transmitted (Tx).

Once you end the connection, all numbers reset to zero.

Ending a Connection

To end your network connection:

� Click Disconnect in Watcher Lite.

Note: Even though the number of bytes sent and received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.



118 Section 4A: Your Card: The Basics (Mac)

Displaying Your Phone Number and ESN

You can view your phone number (“Directory Number”) and ESN in the “About 
Sprint Device” window.

To display the “About Sprint Device” window:

� From the Extras item on the Sierra Wireless Watcher menu, select About Sprint 
Device.

Security

When it is disconnected, you can lock your card so that others cannot use the card 
and your account. A four-digit lock code is needed to unlock the card.

Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service 
provider. For assistance, contact Sprint (page 14). 

Configurations that use the Activation Assistant or IOTA set the initial lock code to 
the last four digits of your account phone number whenever a new phone number 
is activated.
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Warning Regarding the Lock Code

If you lock the card and forget the lock code, you will not be able to use the card 
until you receive assistance from Sprint.

When the Card Is Locked

When the card is locked, you can:

� Unlock the card (page 120).

� Power off the card (page 115).

When the card is locked, you cannot:

� Make data connections (the Connect button is unavailable).

� Run the Activation Assistant.

Locking the Card

To lock the card: 

1. End any active connection. (You can lock the card only when it is disconnected; 
page 113.)

2. From the Extras item on the Sierra Wireless Watcher menu, choose Lock Device.

3. In the “Lock Device” window, enter the lock code, and click OK.

When the card is locked, Watcher Lite displays “Device is Locked.” The Connect 
button is unavailable.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated.

Warning: If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.
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Unlocking the Card

When the card is locked, Watcher Lite displays “Device is Locked.”

To unlock the card: 

1. If the “Unlock Device” window is not displayed: from the Extras item on the 
Sierra Wireless Watcher menu, choose Unlock Device.

2. In the “Unlock Device” window, enter the lock code (PIN) and click OK.

� If you can’t recall your lock code, try using the last four digits of your card’s 
phone number. If this doesn’t work, call Sprint Customer Service at 
1-888-788-4727 (business use) or 1-888-715-4588 (personal use).

When the card is unlocked, Watcher Lite no longer displays “Device is Locked.”

Uninstalling the Watcher Lite Software

To remove the Watcher Lite software from your computer:

1. Exit Watcher Lite (page 116).

2. Remove the card. (See “Removing the Card [Mac]” on page 30.)

3. On your Mac desktop, double-click SierraUninstall.pkg:

Note: As part of the software removal process you will be prompted to restart your 
computer; save any open documents.
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4. In the “Welcome to the Sierra Wireless Remove Installer” window, click 
Continue.

5. In the “Select a Destination” window, choose the volume onto which you had 
installed the Watcher Lite software, and then click Continue.
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6. In the “Easy Install on ...” window, click Upgrade.

7. If the “Authenticate” window appears, enter your Mac user name and 
password, and then click OK.

8. In the window with the message that you will have to restart your computer, 
click Continue Installation.
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9. Click Restart.
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Sec tion 4B

Menu Options (Mac)

In This Section

� Watcher Lite Menu Options

This chapter describes each menu option you may encounter while using your 
card and the Watcher Lite software on your Mac computer.
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Watcher Lite Menu Options

The following table describes the menu options available from the Extras item on 
the Sierra Wireless Watcher menu.

Menu Item Description

Turn Sprint 
Device Off

 Power off your card.

See “Powering the Card Off” on page 115.

Activation Activate your card.

See “Activation Assistant” on page 38.

Data 
Provisioning

Provision your card, after you’ve activated it.

See step 7 on page 39.

Lock Device / 
Unlock 
Device

Lock your card so that others cannot use it to access your 
account; unlock your card so that you can use it.

See “Locking the Card” on page 119, or “Unlocking the Card” 
on page 120.

About Sprint 
Device

View information about the card.

See “Displaying Your Phone Number and ESN” on page 118.

Open 
Internet 
Connect

View, configure, and use the data and VPN connections 
available on your computer (for example, WWAN).
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Sec tion 4C

Frequently Asked Questions (Mac)

In This Section

� Questions about My Account

� Questions about Watcher Lite

� Questions about GPS and Sprint Location Services

� Other Questions
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Questions about My Account

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

Questions about Watcher Lite

What is Watcher Lite?

Watcher Lite is software that lets you connect to the Sprint Power Vision or 
Sprint Vision network. Watcher Lite takes advantage of the increased data speeds 
offered by the Sprint Mobile Broadband Network.

How fast is the connection with Watcher Lite?

The Sprint Mobile Broadband Network allows you to connect to the Internet at 
speeds of up to 3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps 
(1X). Average connection speeds are:

� For 1xEV-DO Rev. A: between 600 kbps and 1.4 Mbps downlink from the 
network, and between 350 and 500 kbps uplink to the network;

� For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, 
and between 40 and 80 kbps uplink to the network;

� For 1X: between 40 and 80 kbps.

These speeds are faster than dial-up connection speeds.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.

Questions about GPS and Sprint Location Services

Does the Watcher Lite software support GPS and Sprint Location 
Services?

No. The Watcher Lite software does not support GPS and Sprint Location Services.
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Other Questions

Once I connect to the network, how do I access my corporate 
network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate user name and 
password to gain access. For support, contact your company help desk.

How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

Depending on your corporate email client, you can optimize your settings by doing 
the following:

� Work in “offline” mode, and connect only when you need to send or receive 
email.

� Remove the Preview Pane, or use the AutoPreview for headers only.

� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, see the user documentation of your email client.
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Section 4D

Troubleshooting Tips (Mac)

In This Section

� Problems, Causes, and Solutions

� Connect Button Is Unavailable

� Searching for Service

This section helps you diagnose and solve common problems you may experience 
while using your Sprint Mobile Broadband card and the Watcher Lite software on 
a Mac computer.
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Problems, Causes, and Solutions

When properly installed, the Sprint Mobile Broadband card is a highly reliable 
product.

Most problems are caused by one of these issues:

� Network coverage is not available (because you are outside the network, or 
because of an account or network problem).

� The drivers were not properly installed because of a problem with your 
computer’s ExpressCard slot, PC Card slot, or the ExpressCard to PC Card 
adapter.

� System resources required by the card are being used by other devices.

Tips when troubleshooting problems with your card and software:

� Ensure your card is inserted, not locked (page 114), and not powered off 
(page 115).

� Ensure the LED is amber (blinking) or blue.

� To determine the connection status, use the icons (page 111), and messages 
(page 112) in the “Watcher Lite” window.

� Check the Frequently Asked Questions (page 126).

� Use the resources listed in “Getting Help” (page 13).

Connect Button Is Unavailable

If nothing seems to happen when you click the button, ensure that the card is 
properly inserted, not locked (page 114), and not powered off (page 115).

If Watcher Lite displays “Device is Locked,” see page 114.

Note: In some cases, the Connect button can establish a connection to the 
network, even if the button seems unavailable.
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Searching for Service

If Watcher Lite displays “Searching for service” for a long period of time (for 
example, several minutes), try one of the following: 

� Try reorienting your computer.

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� Check with Sprint — a network or account problem may be preventing the card 
from obtaining service.
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Sec tion 5A

Technical Specifications

In This Section

� LED Operation

� Radio Frequency and Electrical Specifications

� Software Specifications

� Environmental Specifications

� Mechanical Specifications

This section describes the LED and various specifications of your Sprint Mobile 
Broadband card.
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LED Operation

Your card has two LED light bars near the antenna end of the card. The LED light 
bars operate as follows:

LED State of LED Indicates

Off The card has no power. The card may not be 
completely inserted into the computer, the 
computer may be turned off or in suspend mode 
(Windows) or sleep mode (Mac), which powers 
down the card, or you have powered the card off 
(for Windows, see page 57; for Mac, see 
page 115).

Blue, not blinking The card has power and is working properly.

Blue, blinking The card’s firmware is being updated. Do not 
remove the card.

Amber, blinking The card is searching for service. If this LED state 
persists, see “Searching for Service” on page 104 
(Windows) or page 117 (Mac).

Amber, not blinking An error has occurred. Eject the card (for 
Windows, see page 28; for Mac, see page 115) 
and reinsert it.

Off No service is available. See “Searching for 
Service” on page 104 (Windows) or page 131 
(Mac).

Amber, blinking Sprint Vision (1X) coverage is detected. Ready to 
connect to the network; to connect, click the GO 
button (Windows) or the Connect button (Mac).

Amber, not blinking The card is connected to the Sprint Vision (1X) 
network, and can send or receive data.
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Blue, blinking Sprint Power Vision (1xEV-DO) coverage is 
detected. Ready to connect to the network; to 
connect, click the GO button (Windows) or the 
Connect button (Mac).

Blue, not blinking The card is connected to the Sprint Power Vision 
(1xEV-DO) network, and can send or receive 
data.

LED State of LED Indicates
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Radio Frequency and Electrical Specifications

Approvals Compliant with:

IS-2000 Release 1.0 (CDMA (1X), IS-707-A Data, IS-856 
(CDMA 1xEV-DO), IS-866, IS-878, IS-890, 
CDMA Development Group

FCC (ID: N7NAC597E)

Industry Canada (ID: 2417C-AC597E)

Voltage +3.3 Vdc from ExpressCard slot

Current Maximum:  1 A

Typical data call current (talk mode):

370 mA (1X)

420 mA (1xEV-DO)

Standby: 50 mA (1xEV-DO/IS-2000 hybrid mode)

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS:  1805 to 1870 MHz

Cellular:  824 to 849 MHz

Receive PCS:  1715 to 1780 MHz

Cellular:  868 to 894 MHz

GPS:   1575.42 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz
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Software Specifications

CDMA 
specification

IS-2000 Release 0

Data service IS-707A

SMS (IS-637) Not supported

FAX Not supported

IOTA Supported

OTASP (IS-683A, 
IS-683B, IS-683C)

Supported

OTAPA Supported

PRL (preferred 
roaming list)

Supported

Authentication Supported

Voice Not supported

NAM Single

E911 Not supported

Position Location Mobile Station based. Supported on Windows only.

TTY/Accessibility Not supported

Mobile IP Supported
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Environmental Specifications

Mechanical Specifications

Operating 
temperature

-30 to +60°C (ambient, outside PCMCIA enclosure)

Storage 
temperature

-20 to +85°C

Humidity 95%, non-condensing

Vibration 147 m/s2 (15 G) sinusoidal vibration, 10 to 2000 Hz, 
20 minute sweep, 12 cycles per axis, 3 axes for 
36 cycles. (12 hours total test time [non-operating])

Drop 30" (76.2 cm) onto vinyl-covered concrete

Dimensions
(W x L x H)

34 mm x 134.6 mm x 5 mm (14 mm - ExpressCard 
extension)

Power button Not supported

Headset jack Not supported

LED Amber/blue



Section 5B: Regulatory Information      141

Sec tion 5B

Regulatory Information

In This Section

� Regulatory Notices

� Patents

� Trademarks

� Copyright

� Limitation of Liability

� Additional Information and Updates

This section contains important regulatory notices about your Sprint Mobile 
Broadband card, and also patent and other information.
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Regulatory Notices

The design of the AirCard 597E ExpressCard complies with U.S. Federal 
Communications Commission (FCC) and Industry Canada (IC) guidelines 
respecting safety levels of radio frequency (RF) exposure for portable devices, 
which in turn are consistent with the following safety standards previously set by 
Canadian, U.S. and international standards bodies:

� ANSI / IEEE C95.1-1999, IEEE Standard for Safety Levels with Respect to Human 
Exposure to Radio Frequency Electromagnetic Fields, 3kHz to 300 GHz

� National Council on Radiation Protection and Measurements (NCRP) Report 86, 
1986, Biological Effects and Exposure Criteria for Radio Frequency 
Electromagnetic Fields

� Health Canada, Safety Code 6, 1999, Limits of Human Exposure to Radio 
frequency Electromagnetic Fields in the Frequency Range from 3 kHz to 300 GHz

� International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, 
Guidelines for limiting exposure to time-varying electric, magnetic, and 
electromagnetic fields (up to 300 GHz)

FCC ID: N7NAC597E

CAUTION: The AirCard 597E ExpressCard has been tested for compliance with FCC/
IC RF exposure limits in the laptop computer(s) configurations with the side 
loading ExpressCard slot and can be used in laptop computers with substantially 
similar physical dimensions, construction, and electrical and RF characteristics. 
This ExpressCard must not be colocated or operated in conjunction with any other 
antenna or transmitter. Use of this device in any other configuration may exceed 
the FCC RF Exposure compliance limit. Note: If this ExpressCard is intended for use 
in any other portable device, you are responsible for separate approval to satisfy 
the SAR requirements of Part 2.1093 of FCC rules.

WARNING (EMI) - United States FCC Information - This equipment has been tested 
and found to comply with the limits for a class B computing device peripheral, 
pursuant to Parts 15, 22, and 24 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful 
interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation.
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If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

� Reorient or relocate the receiving antenna

� Increase the separation between the equipment and receiver

� Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected

� Consult the dealer or an experienced radio/TV technician for help

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that 
may cause undesirable operation.

FCC guidelines stipulate that the antenna should be more than 1.8 cm from the 
user.

The highest reported SAR values of the AirCard 597E ExpressCard by Sierra 
Wireless are:

1. Separation distance of at least 1.8 cm needs to be maintained to user’s lap 
with the AirCard 597E ExpressCard inserted into the bottom ExpressCard slot 
of the laptop computer (1.0 mW/g).

CAUTION: Any changes or modifications not expressly approved by Sprint 
Communications Company L.P. could void the user’s authority to use the 
equipment.

WARNING (EMI) - Canada: This digital apparatus does not exceed the Class B limits 
for radio noise emissions from digital apparatus as set out in the interference 
causing equipment standard entitled “Digital Apparatus,” ICES-003 of the 
Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables 
aux appareils numériques de Classe B préscrites dans la norme sur le matériel 
brouilleur: “Appareils Numériques,” NMB-003 édictée par le ministre des 
Communications.

If you have purchased this product under a United States Government contract, it 
shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense 
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Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) 
Section 52.227-19 for civilian agency contracts or any successor regulations. If 
further government regulations apply, it is your responsibility to ensure 
compliance with such regulations.

Information pertaining to OEM customers

The AirCard 597E ExpressCard has been granted modular approval for mobile 
applications. Integrators may use the AirCard 597E ExpressCard in their final 
products without additional FCC/IC certification if they meet the following 
conditions. Otherwise, additional FCC/IC approvals must be obtained.

1. At least 20 cm separation distance between the antenna and the user’s body 
must be maintained at all times.

2. To comply with FCC/IC regulations limiting both maximum RF output power 
and human exposure to RF radiation, the maximum antenna gain must not 
exceed 5.55 dBi in the Cellular band and 4.95 dBi in the PCS band.

3. The AirCard 597E ExpressCard and its antenna must not be colocated with any 
other transmitter or antenna within a host device.

4. A label must be affixed to the outside of the end product into which the 
AirCard 597E ExpressCard is embedded, with a statement similar to the 
following:

This device contains TX FCC ID: N7NAC597E.

This equipment contains equipment certified under IC: 2417C-AC597E.

5. A user manual with the end product must clearly indicate the operating 
requirements and conditions that must be observed to ensure compliance 
with current FCC/IC RF exposure guidelines.

The end product with an embedded AirCard 597E ExpressCard must pass the 
unintentional emission testing and properly authorized per FCC Part 15 
requirements.

Note: If this ExpressCard is intended for use in a portable device, you are 
responsible for separate approval to satisfy the SAR requirements of FCC 
Part 2.1093 and IC RSS-102.
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Patents

This product may contain technology developed by or for Sierra Wireless Inc.

This product includes technology licensed from QUALCOMM® 3G.

This product is manufactured or sold by Sierra Wireless Inc. or its affiliates under 
one or more patents licensed from InterDigital Group.

Trademarks

SPRINT and other trademarks are trademarks of Sprint Nextel. 

AirCard® and “Heart of the Wireless Machine®” are registered trademarks of Sierra 

Wireless. Watcher® is a trademark of Sierra Wireless, registered in the European 
Community.

Sierra Wireless, the Sierra Wireless logo, and the red wave design are trademarks 
of Sierra Wireless.

ExpressCard is a trademark of PCMCIA.

Windows® is a registered trademark of Microsoft Corporation.

Mac OS is a trademark of Apple Inc., registered in the U.S. and other countries.

QUALCOMM® is a registered trademark of QUALCOMM Incorporated.

All other trademarks are property of their respective owners.

Copyright

©2011 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. SPRINT and other trademarks are trademarks of 
Sprint Nextel.

©2011 Sierra Wireless. All rights reserved.

Document 2130756 Revision 2
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Limitation of Liability

The information in this manual is subject to change without notice and does not 
represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS 
AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR 
ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO 
USE ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS 
AFFILIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY 
ARE FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra Wireless 
product, regardless of the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the Sierra Wireless 
product.

Additional Information and Updates

For up-to-date product descriptions, documentation, application notes, firmware 
upgrades, troubleshooting tips, and press releases, visit:

www.sierrawireless.com

http://www.sierrawireless.com
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Sec tion 6A

Safety and Notices

In This Section

� Important Notice

� Safety and Hazards

This section describes important guidelines regarding your Sprint Mobile 
Broadband card.
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Important Notice

Because of the nature of wireless communications, transmission and reception of 
data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or 
be totally lost. Although significant delays or losses of data are rare when wireless 
devices such as the Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E 
ExpressCard) CDMA modem are used in a normal manner with a well-constructed 
network, they should not be used in situations where failure to transmit or receive 
data could result in damage of any kind to the user or any other party, including 
but not limited to personal injury, death, or loss of property. SPRINT SPECTRUM L.P. 
accepts no responsibility for damages of any kind resulting from delays or errors in 
data transmitted or received using the Sprint Mobile Broadband card by Sierra 
Wireless (AirCard 597E ExpressCard) CDMA modem, or for failure of the 
Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E ExpressCard) to 
transmit or receive such data.

Safety and Hazards

Do not operate the Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E 
ExpressCard) in areas where blasting is in progress, where explosive atmospheres 
may be present, near medical equipment, life support equipment, or any 
equipment which may be susceptible to any form of radio interference. In such 
areas, the Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E 
ExpressCard) MUST BE POWERED OFF. It can transmit signals that could interfere 
with this equipment.

Do not operate the Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E 
ExpressCard) in any aircraft, whether the aircraft is on the ground or in flight. In 
aircraft, the Sprint Mobile Broadband card by Sierra Wireless (AirCard 597E 
ExpressCard) MUST BE POWERED OFF. When operating, it can transmit signals that 
could interfere with various onboard systems.

The driver or operator of any vehicle should not operate the Sprint Mobile 
Broadband card by Sierra Wireless (AirCard 597E ExpressCard) while in control of a 
vehicle. Doing so will detract from the driver or operator's control and operation of 
that vehicle. In some jurisdictions, operating such communications devices while 
in control of a vehicle is an offense.
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Section 6B

Warranty and Terms and Conditions

In This Section

� Warranty

� Subscriber Agreement/General Terms and Conditions of Services

This section describes how to access the Sierra Wireless warranty and contains the 
terms and conditions of service for your Sprint Mobile Broadband card.
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Warranty

To view the Sierra Wireless warranty for your AirCard 597E ExpressCard:

� In Windows Vista or Windows XP, select
Start > All Programs > Sprint > Sierra Wireless Device Warranty.
– or –
In Windows 2000, select Start > Programs > Sprint > Sierra Wireless Device 
Warranty.

– or –

On your Mac desktop, double-click AirCard 59x Warranty.pdf.

Subscriber Agreement
General Terms and Conditions of Services

Please note these terms may not be the most current version. A current version of 
the terms is available at our Web site or upon request.

Para solicitar esta literatura en español, por favor visitar a www.sprint.com.

Basic Definitions

In this document: (1) “we,” “us,” “our” mean Sprint Solutions, Inc. and its affiliates 
doing business as Sprint or Sprint PCS; (2) “you,” “your,” “customer,” and “user” 
mean an account holder or user with us; (3) “Device” means any phone, device, 
accessory or other product we sell to you or that is active on your account with us; 
and (4) “Service” means our offers, rate plans, options, wireless services or Devices 
on your account with us.

The Subscriber Agreement

The Subscriber Agreement (“Agreement”) is a contract under which we provide 
and you accept our Services. In addition to these Terms and Conditions of Service 
(“Ts&Cs”), there are several parts to the Agreement, including, but not limited to, 
the detailed plan or other information on Services we provide or refer you to 
during the sales transaction, and any confirmation materials we may provide you. 
It is important that you carefully read all of the terms of the Agreement.

http://www.sprint.com
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Services Covered By These Ts&Cs & Additional Terms

These Ts&Cs apply to our standard wireless Services and any other Service we 
offer you that references these Ts&Cs. Different terms will apply to most business 
accounts. Additional terms will apply when you use certain Services, typically 
those you can access online (for example, picture/video Services, online forums, 
etc.). Additional terms will also apply if you activate Services as part of a bundle 
with another company’s services (for example, cable services, home phone 
services, etc.). The additional terms for bundled Services may either modify or 
replace certain provisions in these Ts&Cs, including terms relating to activation, 
invoicing/payment, and disputing charges. Also, a different dispute resolution 
provision may apply to services provided by another company (the dispute 
resolution provisions in this Agreement still apply to our Services). You will be 
provided details on any additional terms with your selection of any bundled 
Service.

Our Policies

Services are subject to our business policies, practices and procedures (“Policies”), 
including, but not limited to, our Privacy Policy and Acceptable Use Policy and 
Visitor Agreement – both available at our Web site. You agree to all of our Policies 
when you use our Services. Our Policies are subject to change at anytime with or 
without notice.

When You Accept The Agreement

You must have the legal capacity to accept the Agreement. You accept the 
Agreement when you do any of the following: (a) sign a contract with us on paper 
or electronically; (b) accept Agreement through an oral or electronic statement; (c) 
attempt to or in any way use the Services; (d) pay for the Services; or (e) open any 
package or start any program that says you are accepting the Agreement when 
doing so. If you don’t want to accept the Agreement, don’t do any of these things.

Term Commitments & Early Termination Fees

Many of the Services (for example, rate plans and Device discounts) that we offer 
require you to maintain certain Services with us for a minimum term, usually 1 or 
2 years (“Term Commitment”). You will be charged a fee (“Early Termination Fee”) for 
each line of Service that you terminate early (i.e., prior to satisfying the Term 
Commitment) or for each line of Service that we terminate early for good reason (for 
example, violating the payment or other terms of the Agreement). Early Termination 
Fees are a part of our rates. Your exact Term Commitment and Early Termination 
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Fee may vary based on the Services you select and will be disclosed to you during 
the sales transaction. Carefully review any Term Commitment and Early Termination 
Fee requirements prior to selecting Services. After you have satisfied your Term 
Commitment, your Services continue on a month-to-month basis without any 
Early Termination Fee, unless you agree to extend your Term Commitment or 
agree to a new Term Commitment – for example, by accepting a new rate plan or 
upgrading your Device. As explained directly below, there are instances when you 
will not be responsible for an Early Termination Fee for terminating Services early.

When You Don’t Have To Pay An Early Termination Fee

You aren’t responsible for paying an Early Termination Fee when terminating 
Services: (a) provided on a month-to-month basis; (b) consistent with our 
published trial period return policy; or (c) in response to a materially adverse 
change we make to the Agreement as described directly below.

Our Right To Change The Agreement & Your Related Rights

We may change any part of the Agreement at any time, including, but not limited to, 
rates, charges, how we calculate charges, or your terms of Service. We will provide you 
notice of material changes, and may provide you notice of non-material changes, in a 
manner consistent with this Agreement (see “Providing Notice Under This Agreement” 
paragraph). Except as provided below, if a change we make to the Agreement is 
material and has a material adverse effect on you, you may terminate each line of 
Service materially affected without incurring an Early Termination Fee only if you: 
(a) call us within 30 days after the effective date of the change; and (b) specifically 
advise us that you wish to cancel Services because of a material change to the 
Agreement that we have made. If you do not cancel Service within 30 days of the 
change, an Early Termination Fee will apply if you terminate Services before the 
end of any applicable Term Commitment.

Our Right To Suspend Or Terminate Services

We can, without notice, suspend or terminate any Service at any time for any reason, 
including, but not limited to: (a) late payment; (b) exceeding an Account Spending 
Limit (“ASL”); (c) harassing/threatening our employees or agents; (d) providing 
false information; (e) interfering with our operations; (f) using/suspicion of using 
Services in any manner restricted by or inconsistent with the Agreement; 
(g) breaching the Agreement, including our Policies; (h) providing false, 
inaccurate, dated or unverifiable identification or credit information, or becoming 
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insolvent or bankrupt; (i) modifying a Device from its manufacturer specifications; 
or ( j) if we believe the action protects our interests, any customer’s interests or our 
network.

Your Ability To Change Services & When Changes Are Effective

You typically can change Services upon request. In some instances, changes may 
be conditioned on payment of an Early Termination Fee or certain other charges, 
or they may require you to accept a new Term Commitment. Changes to Services 
are usually effective at the start of your next full invoicing cycle. If the changes 
take place sooner, your invoice may reflect pro-rated charges for your old and 
new Services.

Your Right To Terminate Services

You can terminate Services at any time by calling us and requesting that we 
deactivate all Services. You’re responsible for all charges billed or incurred prior to 
deactivation. If Services are terminated before the end of your invoicing cycle, we 
won’t prorate charges to the date of termination and you won’t receive a credit or 
refund for any unused Services. Except as provided above, you must also pay us an 
Early Termination Fee for each line of Service that you terminate early.

Credit Checks & Credit Information

We agree to provide you Services on the condition you have and maintain 
satisfactory credit according to our standards and policies. You agree to provide 
information we may request or complete any applications we may provide you to 
facilitate our review. We rely on the credit information you furnish, credit bureau 
reports or other data available from commercial credit reference services, and 
other information (such as payment history with us) to determine whether to 
provide or continue to provide you Services. The Services we offer you can vary 
based on your credit history. We may at any time, based on your credit history, 
withdraw or change Services, or place limits or conditions on the use of our 
Services. You agree to provide us updated credit information upon request. 
We may provide your payment history and other account billing/charge 
information to any credit reporting agency or industry clearinghouse.

Account Spending Limits (“ASL”)

An ASL is a temporary or permanent limit (typically based on credit history, 
payment history, or to prevent fraud) we place on the amount of unpaid charges 
you can accumulate on your account, regardless of when payment on those 
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charges is due. We reserve the right to determine which charges count towards an 
ASL. If you have an ASL, we may suspend your Services without prior notice if your 
account balance reaches the ASL, even if your account is not past due. We may 
impose or increase an ASL at any time with notice. An ASL is for our benefit only 
and should not be relied on by you to manage usage.

Deposits & Returning Deposits

We may at any time require a deposit, as a guarantee of payment, for you to 
establish or maintain Service (“Deposit”). By providing us a Deposit, you grant us a 
security interest for all current or future amounts owed to us. We may change the 
Deposit at any time with notice. You can’t use a Deposit to make or delay 
payments. The Deposit, the length of time we hold the Deposit, and changes to 
the Deposit are determined based on your credit history, payment history and 
other factors. Unless prohibited by law, we may mix Deposits with our other funds 
and it won’t earn interest and we reserve the right to return the Deposit as a credit 
on your invoice at anytime. If your Services are terminated for any reason, we may 
keep and apply your Deposit to any outstanding charges. We’ll send any 
remaining portion of Deposit to your last known address within 90 days after your 
final invoice – if it is returned to us, we will forward it on to the appropriate state 
authorities to the extent required by law.

Restrictions On Using Services

You can’t use our Services: (a) to transmit content/messages that are, or in any 
manner that is, illegal, fraudulent, threatening, abusive, defamatory, or obscene; 
(b) in a way that could cause damage or adversely affect our customers, 
reputation, network, property or Services; (c) to communicate any unsolicited 
commercial voice, text, SMS, or other message; (d) to infringe on the copyright of 
another, or upload or transmit any “virus”, “worm”, or malicious code; or (e) in any 
way prohibited by the terms of our Services, the Agreement or our Policies.

Your Device, Number & E-mail Address; Caller ID

We don’t manufacture any Device we might sell to you or that is associated with 
our Services, and we aren’t responsible for any defects, acts or omissions of the 
manufacturer. The only warranties on your Device are the limited warranties given to 
you by the manufacturer directly or that we pass through. Your Device is designed 
exclusively for use on our network and in other coverage areas we make available 
to you. It will not accept wireless service from another carrier. Except for any legal 
right you may have to port/transfer your phone number to another carrier, you 
have no and cannot gain any (for example, through publication, use, etc.) 
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proprietary, ownership or other rights to any phone number, identification 
number, e-mail address or other identifier we assign to you, your Device or your 
account. We’ll notify you if we decide to change or reassign them.

Porting/Transferring Phone Numbers

We don’t guarantee that number transfers to or from us will be successful. If you 
authorize another carrier to transfer a number away from us, that is considered a 
request by you to us to terminate all of the Services associated with that number. 
You’re responsible for all charges billed or incurred prior to deactivation and for 
any applicable Early Termination Fees.

Coverage; Where Your Device Will Work

Our coverage maps are available at our stores and at our Web site. The specific 
network coverage you get will depend on the radio transmissions your Device can 
pick up and Services you’ve chosen. Our coverage maps provide high level estimates 
of our coverage areas when using Services outdoors under optimal conditions. Coverage 
isn’t available everywhere. Estimating wireless coverage and signal strength is not an 
exact science. There are gaps in coverage within our estimated coverage areas that, 
along with other factors both within and beyond our control (network problems, 
software, signal strength, your Device, structures, buildings, weather, geography, 
topography, etc.), may result in dropped and blocked connections, slower data speeds, 
or otherwise impact the quality of Service. Services that rely on location information, 
such as E911 and GPS navigation, depend on your Device’s ability to acquire satellite 
signals (typically not available indoors) and network coverage.

Roaming

“Roaming” typically refers to coverage on another carrier’s network that we make 
available to you based on our agreements with other carriers. These agreements 
may change from time to time and roaming coverage is subject to change. Your 
ability to receive roaming coverage depends on the radio transmissions your 
Device can pick up. You can pick up roaming coverage both within and outside our 
network coverage areas. Your Device will generally indicate when you’re roaming. 
Depending on your Services, separate charges or limits on the amount of minutes 
used while roaming may apply. Certain Services may not be available or work the 
same when roaming (including data Services, voicemail, call waiting, etc.).
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About Data Services & Content

Our data Services and your Device may allow you to access the internet, text, 
pictures, video, games, graphics, music, email, sound and other materials (“Data 
Content”) or send Data Content elsewhere. Some Data Content is available from 
us or our vendors, while other Data Content can be accessed from others (third 
party Web sites, games, ringers, etc.). We make absolutely no guarantees about 
the Data Content you access on your Device. Data Content may be: (1) unsuitable for 
children/minors; (2) unreliable or inaccurate; or (3) offensive, indecent or objectionable. 
You’re solely responsible for evaluating the Data Content accessed by you or anyone on 
your account. We strongly recommend you monitor data usage by children/minors. 
Data Content from third parties may also harm your Device or its software. To 
protect our network, Services, or for other reasons, we may place restrictions on 
accessing certain Data Content (such as certain Web sites, applications, etc.), 
impose separate charges, limit throughput or the amount of data you can transfer, 
or otherwise limit or terminate Services. If we provide you storage for Data 
Content you have purchased, we may delete the Data Content with notice or place 
restrictions/limits on the use of storage areas. You may not be able to make or 
receive voice calls while using data Services.

Specific Terms & Restrictions On Using Data Services

In addition to the rules for using all of our other Services, unless we identify the 
Service or Device you have selected as specifically intended for that purpose (for 
example, wireless routers, Data Link, etc.), you can’t use our data Services: (1) with 
server devices or host computer applications, or other systems that drive 
continuous heavy traffic or data sessions; and (2) as a substitute or backup for 
private lines or frame relay connections. We reserve the right to limit or suspend 
any heavy, continuous data usage that adversely impacts our network 
performance or hinders access to our network. If your Services include unlimited 
Web or data access, you also can’t use your Device as a modem for computers or 
other equipment, unless we identify the Service or Device you have selected as 
specifically intended for that purpose (for example, with “phone as modem” 
plans, Sprint Mobile Broadband card plans, wireless router plans, etc.).

Activation & Miscellaneous Charges

Based on our Policies, we may charge activation, prepayment, reactivation, 
program or other fees to establish or maintain Services. Certain transactions may 
also be subject to a charge (for example, convenience payment, changing phone 
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numbers, handset upgrades, etc.). You will be provided notice of these types of 
fees before we complete the requested transaction.

Account & Service Charges; Pro-rating; Unused Minutes

You are responsible for all charges associated with your account and the Services on 
your account, no matter who uses the Services. Charges include, but are not limited 
to, the monthly recurring charges, usage charges, taxes, surcharges and fees 
associated with your Services. These charges are described or referred to during 
the sales transaction, in our marketing materials, and in confirmation materials 
we may send to you.

How We Calculate Your Charges For Billing Purposes

Regular Voice Calls: We round up partial minutes of use to the next full minute. 
Time starts when you press “Talk” or your Device connects to the network and 
stops when you press “End” or the network connection otherwise breaks. You’re 
charged for all calls that connect, even to answering machines. You won’t be 
charged for unanswered calls or if you get a busy signal. For incoming calls 
answered, you’re charged from the time shortly before the Device starts ringing 
until you press “End” or the network connection otherwise breaks. If charges vary 
depending on the time of day that you place or receive calls (e.g., Nights and 
Weekend plans), you’re charged for the entire call based on the rate that applies to 
the time period in which the call starts.

iDEN Walkie-Talkie Charges: Charges for walkie-talkie calls are billed to the person 
who starts the call and calculated by multiplying the duration of the call by the 
applicable rate and number of participants. You’re charged at least 6 seconds of 
airtime for each call you start; subsequent communications in the same call are 
rounded up to and billed to the next second. Time begins when you press any 
button to start a walkie-talkie call and ends approximately 6 seconds after 
completion of a communication to which no participant responds – subsequent 
walkie-talkie communications are considered new calls. Depending on your plan, 
nationwide, international or group walkie-talkie calls may use the local walkie-
talkie minutes in your plan and result in additional charges. Responses to call alert 
transmissions are treated as new walkie-talkie transmissions even when 
responding within 6 seconds of receiving the alert.

Data Usage: Unless we specifically tell you otherwise, data usage is measured in 
bytes, kilobytes and megabytes – not in minutes/time. 1024 bytes equals 
1 kilobyte (“KB”), and 1024 KB equals 1 megabyte. Bytes are rounded up to 
kilobytes, so you will be charged at least 1 KB for each data usage session (“data 
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session”). Rounding occurs at the end of each data session, and sometimes during 
a data session. Depending on your data Services, usage may be charged against an 
allowance or on a fixed price per KB. If you are charged on a fixed price per KB, any 
fractional cents will be rounded up to the next cent. You are charged for all data 
directed to your Device’s internet address, including data sessions you did not 
initiate and for incomplete transfers. As long as your Device is connected to our 
data network, you may incur data charges. Examples of data you will be charged 
for includes the size of a requested file or Data Content (game, ringer, etc.), Web 
page graphics (logos, pictures, banners, advertisement, etc.), additional data used 
in accessing, transporting and routing the file on our network, data from partial or 
interrupted downloads, re-sent data, and data associated with unsuccessful 
attempts to reach Web sites or use applications. These data charges are in 
addition to any charges for the Data Content itself (game, ringer, etc.). Data used 
and charged to you will vary widely, even between identical actions or data 
sessions. Estimates of data usage – for example, the size of downloadable files – 
are not reliable predictors of actual usage. Your bill won’t separately list the 
number of KB attributed to a specific action/data session.

Your Bill

Your bill provides you notice of your charges. It reflects monthly recurring charges 
(usually billed one bill cycle in advance) and usage/transaction specific charges 
(usually billed in the bill cycle in which they’re incurred). Some usage charges, such 
as those that depend on usage information from a third party, may be billed in 
subsequent bill cycles and result in higher than expected charges for that month. 
Bill cycles and dates may change from time to time. Your bill may also include other 
important notices (for example, changes to this Agreement, to your Service, legal 
notices, etc.). Your paper bill may not include individual call detail. Your call detail is 
available online. Paper bills with call detail may be subject to an additional charge. 
If you choose internet billing, you will not receive paper bills.

Your Payments; Late Fees

Payment is due in full as stated on your bill. If we do not receive payment in full by 
the date specified on your bill, a late payment charge, which may be charged at 
the highest rate permissible by law, may be applied to the total unpaid balance. 
We may also charge you any costs we pay to a collection agency to collect unpaid 
balances from you. If we bill you for amounts on behalf of a third party, payments 
received are first applied to our charges. You may be charged additional fees for 
certain methods of payment. We may charge you, up to the highest amount 
permitted by law, for returned checks or other payments paid by you and denied 
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for any reason by a financial institution. Acceptance of payments (even if marked 
“paid in full”) does not waive our right to collect all amounts that you owe us. We 
may restrict your payment methods to cashier’s check, money order, or other 
similar secure form of payment at any time for good reason.

Taxes & Government Fees

You agree to pay all federal, state and local taxes, fees and other assessments that 
we’re required by law to collect on the Services we provide you and remit to the 
government. These charges may change from time to time without advance 
notice. If you’re claiming any tax exemption, you must provide us with a valid 
exemption certificate. Tax exemptions generally won’t be applied retroactively.

Surcharges

You agree to pay the surcharges, fees and other charges that we assess to recoup 
our government costs or costs of complying with certain government programs 
(“Surcharges”). Surcharges aren’t taxes or government mandated charges; they’re 
charges we choose to collect from you. Surcharges are subject to change, sometimes on 
a monthly or quarterly basis. Examples of Surcharges include, but are not limited to: 
Universal Service Fund, E911, Federal Programs Cost Recovery, Federal Wireless 
Number Pooling and Portability, and gross receipts charges. We will make efforts 
to provide you notice of any changes to Surcharges in a manner consistent with 
this Agreement (see “Providing Notice Under This Agreement” paragraph). 
However, since most Surcharges are based on amounts set by the government or 
based on government formulas, it will not always be possible to provide advance 
notice of new Surcharges or changes in the amount of existing Surcharges. 
Information on Surcharges is provided during the sales transaction and is 
available at our Web site.

Disputing Charges - You Must Still Pay Undisputed Charges

Any dispute to a charge on your bill must be made within 60 days of the date of 
the bill that initially contained the charge. Disputes can only be made by calling or 
writing us as directed on your invoice or elsewhere. You accept all charges not 
properly disputed within the above time period – undisputed charges must still be 
paid as stated on your bill.
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Protecting Our Network & Services

We can take any action to: (1) protect our network, our rights and interests, or the 
rights of others; or (2) optimize or improve the overall use of our network and 
Services. Some of these actions may interrupt or prevent legitimate 
communications and usage – for example, message filtering/blocking software to 
prevent SPAM or viruses, limiting throughput, limiting access to certain Web sites, 
applications or other Data Content, etc. For additional information on what we do 
to protect our customers, network, Services and equipment, see our Acceptable 
Use Policy and Visitor Agreement at our Web site.

Your Privacy

You agree to the terms of our Privacy Policy, available at our Web site, when you 
use our Services. This policy may change from time to time, so review this policy 
with regularity and care. Among other things, the policy includes important 
information on what information we collect about you, how we use that 
information, and with whom we share that information (for example, to provide 
you certain Services, to protect our rights and interests, to respond to legal 
process, to facilitate a merger, etc.). Also, to ensure the quality of our Services and 
for other lawful purposes, we may also monitor or record calls between us (for 
example, your conversations with our customer service or sales departments). 
If you do not agree with the terms of our Privacy Policy, do not purchase or use 
our Services.

Location Based Services

Our network generally knows the location of your Device when it is outdoors and 
turned on. By using various technologies to locate your Device, we can provide 
enhanced emergency 911 services, and optional location-sensitive services 
provided by us or a third party. Environmental factors (such as structures, 
buildings, weather, geography, landscape, and topography) can significantly 
impact the ability to access your Device’s location information and use of location-
sensitive services. The terms and conditions of any location-sensitive service that 
you purchase from us may provide more information about how location 
information is used and disclosed. Use of some of location-sensitive services may 
require network coverage. If any Device on your account uses a location-sensitive 
service, you (the accountholder) must clearly and regularly notify the actual user of your 
Device that their location may be tracked or discovered. For additional information on 
location-sensitive services, see our Privacy Policy at our Web site.
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911 Or Other Emergency Calls

Public Safety Officials advise that when making 911 or other emergency calls, you 
should always be prepared to provide your location information. Unlike traditional 
wireline phones, depending on a number of factors (e.g., whether your Device is 
GPS enabled, where you are, whether local emergency service providers have 
upgraded their equipment, etc.), 911 operators may not know your phone 
number, your location or the location of your Device. In certain circumstances, an 
emergency call may be routed to a state patrol dispatcher or alternative location 
set by local emergency service providers. Enhanced 911 service (“E911”), where 
enabled by local emergency authorities, uses GPS technology to provide location 
information. Even when available, however, E911 does not always provide 
accurate location information. If your Device is indoors or for some other reason 
cannot acquire a satellite signal, you may not be located. Some Devices have a 
safety feature that prevents use of the keypad after dialing 911 – you should 
follow voice prompts when interacting with emergency service providers 
employing IVR systems to screen calls.

If Your Device Is Lost or Stolen

Call us immediately if your Device is lost or stolen because you may be responsible 
for usage charges before you notify us of the alleged loss or theft. You agree to 
cooperate if we choose to investigate the matter (provide facts, sworn statements, 
etc.). We may not waive any Early Termination Fees if you choose to terminate 
Services as a result of loss or theft of your Device.

Disclaimer of Warranties

WE MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING (TO THE EXTENT ALLOWED BY LAW) ANY IMPLIED WARRANTY OF 
MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR 
PURPOSE CONCERNING YOUR SERVICES (INCLUDING YOUR DEVICE). WE DON’T 
PROMISE UNINTERRUPTED OR ERROR-FREE SERVICES AND DON’T AUTHORIZE 
ANYONE TO MAKE WARRANTIES ON OUR BEHALF.

You Agree We Are Not Responsible For Certain Problems

You agree that neither we nor our vendors, suppliers or licensors are responsible 
for any damages resulting from: (a) anything done or not done by someone else; 
(b) providing or failing to provide Services, including, but not limited to, 
deficiencies or problems with a Device or network coverage (for example, dropped, 
blocked, interrupted calls/messages, etc.); (c) traffic or other accidents, or any 
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health-related claims relating to our Services; (d) Data Content or information 
accessed while using our Services; (e) an interruption or failure in accessing or 
attempting to access emergency services from a Device, including through 911, 
Enhanced 911 or otherwise; (f) interrupted, failed, or inaccurate location 
information services, (g) information or communication that is blocked by a spam 
filter, or (h) things beyond our control, including acts of God (for example, 
weather-related phenomena, fire, earthquake, hurricane, etc.), riot, strike, war, 
terrorism or government orders or acts.

You Agree Our Liability Is Limited - No Consequential Damages.

TO THE EXTENT ALLOWED BY LAW, OUR LIABILITY FOR MONETARY DAMAGES FOR 
ANY CLAIMS YOU MAY HAVE AGAINST US IS LIMITED TO NO MORE THAN THE 
PROPORTIONATE AMOUNT OF THE SERVICE CHARGES ATTRIBUTABLE TO THE 
AFFECTED PERIOD. UNDER NO CIRCUMSTANCES ARE WE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES OF ANY NATURE 
WHATSOEVER ARISING OUT OF OR RELATED TO PROVIDING OR FAILING TO 
PROVIDE SERVICES IN CONNECTION WITH A DEVICE, INCLUDING, BUT NOT 
LIMITED TO, LOST PROFITS, LOSS OF BUSINESS, OR COST OF REPLACEMENT 
PRODUCTS AND SERVICES.



Section 6B: Warranty and Terms and Conditions      165

DISPUTE RESOLUTION
We Agree To First Contact Each Other With Any Disputes

We each agree to first contact each other with any disputes and provide a written 
description of the problem, all relevant documents/information and the proposed 
resolution. You agree to contact us with disputes by calling or writing us as 
instructed on your invoice. We will contact you by letter to your billing address or 
on your Device.

Instead Of Suing In Court, We Each Agree To Arbitrate Disputes

We each agree to finally settle all disputes (as defined and subject to any specific 
exceptions below) only by arbitration. In arbitration, there’s no judge or jury and 
review is limited. However, just as a court would, the arbitrator must honor the 
terms and limitations in the Agreement and can award the same damages and 
relief, including any attorney’s fees authorized by law. The arbitrator’s decision and 
award is final and binding, with some exceptions under the Federal Arbitration Act 
(“FAA”), and judgment on the award may be entered in any court with jurisdiction. 
We each also agree as follows:

(1) “Disputes” are any claims or controversies against each other related in any way to 
our Services or the Agreement, including, but not limited to, coverage, Devices, privacy, 
or advertising, even if it arises after Services have terminated – this includes claims 
you bring against our employees, agents, affiliates or other representatives, or 
that we bring against you.

(2) If either of us wants to arbitrate a dispute, we agree to send written notice to 
the other providing a description of the dispute, previous efforts to resolve the 
dispute, all supporting documents/information, and the proposed resolution. 
Notice to you will be sent to your billing address and notice to us will be sent to: 
General Counsel; Arbitration Office; 2001 Edmund Halley Drive VARESP0513-502; 
Reston, Virginia 20191. We agree to make attempts to resolve the dispute. If we 
cannot resolve the dispute within forty-five (45) days of receipt of the notice to 
arbitrate, then we may submit the dispute to formal arbitration.

(3) The FAA applies to this Agreement and arbitration provision. We each agree the 
FAA’s provisions, not state law, govern all questions of whether a dispute is subject 
to arbitration.

(4) The arbitration will be administered by the National Arbitration Forum (“NAF”) 
under its arbitration rules. If any NAF rule conflicts with the terms of the 
Agreement, the terms of the Agreement apply. You can obtain procedures, rules, 
and fee information from the NAF at 1-800-474-2371 or www.adrforum.com.

http://www.adrforum.com
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(5) Unless we each agree otherwise, the Arbitration will be conducted by a single 
neutral arbitrator and will take place in the county of your last billing address. The 
federal or state law that applies to the Agreement will also apply during the 
arbitration.

(6) We each agree not to pursue arbitration on a classwide basis. We each agree that 
any arbitration will be solely between you and us (not brought on behalf of or together 
with another individual’s claim). If for any reason any court or arbitrator holds that this 
restriction is unconscionable or unenforceable, then our agreement to arbitrate doesn’t 
apply and the dispute must be brought in court.

(7) We each are responsible for our respective costs relating to counsel, experts, 
and witnesses, as well as any other costs relating to the arbitration. However, we 
will cover any arbitration administrative or filing fees above: (a) $25 if you are 
seeking less than $1,000 from us; or (b) the equivalent court filing fees for a court 
action in the appropriate jurisdiction if you are seeking $1,000 or more from us.

Exceptions To Our Agreement To Arbitrate Disputes

Either of us may bring qualifying claims in small claims court. In addition, this 
arbitration provision does not prevent you from filing your dispute with any 
federal, state or local government agency that can, if the law allows, seek relief 
against us on your behalf.
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No Class Actions

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO PURSUE 
DISPUTES ON A CLASSWIDE BASIS; THAT IS, TO EITHER JOIN A CLAIM WITH THE 
CLAIM OF ANY OTHER PERSON OR ENTITY, OR ASSERT A CLAIM IN A 
REPRESENTATIVE CAPACITY ON BEHALF OF ANYONE ELSE IN ANY LAWSUIT, 
ARBITRATION OR OTHER PROCEEDING.

No Trial By Jury

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO TRIAL BY JURY 
IN ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

Indemnification

You agree to indemnify, defend and hold us harmless from any claims arising out 
of your actions, including, but not limited to, failing to provide appropriate notices 
regarding location-sensitive services (see “Location Based Services” paragraph), or 
violating this Agreement, any applicable law or regulation or the rights of any 
third party.

Providing Notice To Each Other Under The Agreement

Except as the Agreement specifically provides otherwise, you must provide us 
notice by calling or writing us as instructed on your invoice. We will provide you 
notice in your bill, correspondence to your last known billing address, to any fax 
number or e-mail address you’ve provided us, by calling you on your home phone 
or Device, by voice message on your Device or home phone, or by text message on 
your Device.

Other Important Terms

Subject to federal law or unless the Agreement specifically provides otherwise, 
this Agreement is governed solely by the laws of the state encompassing the area 
code assigned to your Device, without regard to the conflicts of law rules of that 
state. If either of us waives or doesn’t enforce a requirement under this Agreement 
in an instance, we don’t waive our right to later enforce that requirement. Except 
as the Agreement specifically provides otherwise, if any part of the Agreement is 
held invalid or unenforceable, the rest of this Agreement remains in full force and 
effect. This Agreement isn’t for the benefit of any 3rd party except our corporate 
parents, affiliates, subsidiaries, agents, and predecessors and successors in 
interest. You can’t assign the Agreement or any of your rights or duties under it. 
We can assign the Agreement. The Agreement and the documents it incorporates 



168 Section 6B: Warranty and Terms and Conditions

make up the entire agreement between us and replaces all prior written or spoken 
agreements – you can’t rely on any contradictory documents or statements by 
sales or service representatives. The rights, obligations and commitments in the 
Agreement that, by their nature, would logically continue beyond the termination 
of Services (including, but not limited to, those relating to billing, payment, 911, 
dispute resolution, no class action, no jury trial), survive termination of Services.

© 2007 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. SPRINT and other trademarks are trademarks of 
Sprint Nextel. iDEN is a trademark of Motorola, Inc.
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Glossary

1X
One Times Radio Transmission Technology (the “one times” refers to the frequency 
spectrum). Also known as Sprint Vision. Supports Internet connections with data 
rates up to 153 kbps. Actual speed depends on the network conditions. Compare 
to 1xEV-DO.

1xEV-DO
A high-speed standard for cellular packet data communications. Also known as 
Sprint Power Vision.

1xEV-DO Rev. A supports Internet connections with data rates up to 3.1 Mbps 
(downlink from the network) and 1.8 Mbps (uplink to the network). Average data 
rates are 600 kbps - 1.4 Mbps (downlink from the network) and 350-500 kbps 
(uplink to the network).

1xEV-DO Rev. 0 supports Internet connections with data rates up to 2.4 Mbps 
(downlink from the network) and 153 kbps (uplink to the network). Average data 
rates are 400-700 kbps (downlink from the network) and 40-80 kbps (uplink to the 
network)

Actual speed depends on the network conditions. Compare to 1X.

bps
bits per second—The actual data speed over the transmission medium.

broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

CDMA
Code Division Multiple Access—A wideband spread spectrum technique used in 
digital cellular, personal communications services, and other wireless networks. 
Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, 
thus allowing many active users to share the same channel. Each user is assigned 
a unique digital code, which differentiates the individual conversations on the 
same channel.

dBm
decibels relative to 1 milliwatt



172 Glossary

dormant
The network switches the data connection into dormant mode if there is no traffic 
on the connection for some time. When you resume data traffic, the high-speed 
data connection becomes active.

The data connection may also go dormant while a GPS fix is being acquired.

ESN
Electronic Serial Number—The unique serial number assigned to the card for 
cellular network use. Either the ESN or MEID is on the label on the card, and is also 
displayed in the “Device Info & Diagnostics” window (Windows; page 89) or 
“About Sprint Device” window (Mac; page 118). See also MEID.

ExpressCard™
Add-in memory and communications cards for portable computers. ExpressCard is 
a trademark of the PCMCIA.

FCC
Federal Communications Commission—The U.S. federal agency that is responsible 
for interstate and foreign communications. The FCC regulates commercial and 
private radio spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast licensing. Consult 
www.fcc.gov.

firmware
Software stored in ROM or EEPROM memory; essential programs that remain even 
when the system is turned off. Firmware is easier to change than hardware but 
more permanent than software stored on disk.

fix
GPS location information obtained from the network.

GPS
Global Positioning System—A system that uses a series of 24 geosynchronous 
satellites to provide location data.

HEPE
Horizontal Estimated Position Error—Relates to GPS accuracy.

IS
Interim Standard—After receiving industry consensus, the TIA forwards the 
standard to ANSI for approval.

http://www.fcc.gov
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kbps
kilobits per second—Actually 1000, not 1024, as used in computer memory size 
measurements of kilobytes.

LAN
Local Area Network

LED
Light Emitting Diode—A semiconductor diode that emits visible or infrared light.

Mbps
Megabits per second

MEID
Mobile Equipment Identifier—The unique second-generation serial number 
assigned to the Sprint Mobile Broadband card for cellular network use. Either the 
MEID or ESN is on the label on the card, and is also displayed in the “Device Info & 
Diagnostics” window (Windows; page 89) or “About Sprint Device” window (Mac; 
page 118). Compare to ESN.

MHz
megahertz—One million cycles per second

PC Card™
Add-in memory and communications cards for portable computers. PC Card is a 
trademark of the PCMCIA.

PCMCIA
Personal Computer Memory Card International Association—The organization that 
standardizes ExpressCards and PC Cards.

PCS
Personal Communications Services—A cellular communication infrastructure.

roaming
A wireless subscriber is in an area where service is obtained from a wireless service 
provider other than Sprint. This may be subject to roaming charges. 
Sprint Location Services may not be available.
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Sprint Connection Manager
Software that allows you to manage the Sprint Mobile Broadband card’s actions 
and monitor your connections on a Windows computer.

Sprint Mobile Broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

Sprint Power Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1xEV-DO.

Sprint Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1X.

system tray
Usually located in the bottom right of the screen (near the clock). When 

Sprint Connection Manager is running, it places an icon  in this area, which you 
can use to monitor the connection state (page 54). If you right-click the icon, a 
shortcut menu is displayed (page 75):

TIA
Telecommunications Industry Association—A standards-setting trade organization, 
whose members provide communications and information technology products, 
systems, distribution services, and professional services in the United States and 
around the world. Consult www.tiaonline.org.

ToolTip
Text that displays when you position the mouse pointer over an area of the screen 
(for example, over an indicator).

http://www.tiaonline.org
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TRU-Install
A Sierra Wireless feature that installs the necessary software and drivers the first 
time you insert the card into your Windows or Mac computer. An installation CD is 
not required.

VPN
Virtual Private Network

WAN
Wide Area Network

Watcher Lite
Software that allows you to manage the Sprint Mobile Broadband card’s actions 
and monitor your connections on a Mac computer.
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Index
Symbols
$GPGGA, 99
$GPGSA, 99
$GPGSV, 99
$GPRMC, 99

Numerics
1-888-715-4588 (Sprint Customer Service), 

14
1-888-788-4727 (Sprint Customer Service), 

14
1X Only (Network Mode) (Windows), 81
1X, 1xEV-DO

description, 5
amount of data transferred (Mac), 112, 

117
amount of data transferred (Windows), 

65
application to automatically launch upon 

network connection (Windows), 64
automatically connecting when ready 

(Windows), 81
cannot connect (Windows), 105
connecting (Mac), 116
connecting (Windows), 62
coverage, determining (Mac), 111
coverage, determining (Windows), 55
dormant indicator (Windows), 47
ending a connection (Mac), 117
ending a connection (Windows), 66
icons (Mac), 111
icons (Windows), 46
roaming indicator (Mac), 112
roaming indicator (Windows), 46
transmit/receive indicator (Windows), 47
warning when roaming (Windows), 63

1xEV-DO Only (Network Mode) (Windows), 
81

2000, Windows, 9
3G. See 1X, 1xEV-DO.

A
About Sprint Mobile Broadband, 92
accessibility, 139
accessories, 14
account

accessing, 14
charges, 159
setting up (Mac), 37

setting up (Windows), 32
Account Spending Limits (ASL), 155
accuracy, GPS (Windows only), 48
"Acquired" message (Windows only), 53
activating the device

Mac, 37
Windows, 32

activation
Mac, 37
Windows, 32

Activation Assistant (Mac), 38
activation code

Mac, 39
Windows, 34

Activation Wizard (Windows)
overview, 32
Activation Wizard button, 82

Activation, One Touch, 5, 33
adapter for PC Card slot

included in package, 6
inserting into computer, 27
removing from computer, 29

Advanced Forward Link Trilateration (AFLT) 
(Windows only), 97

AFLT (Advanced Forward Link Trilateration) 
(Windows only), 97

agreement, subscriber, 152
aircraft

hazards warning, 150
powering the card off in (Mac), 115
powering the card off in (Windows), 57

Alert Log (Windows), 88
alerts (Windows), 88
altitude (Windows only), 49
Always Ask (Roam Guard) (Windows), 64
always on

billing, 94, 127
set (Windows), 45

Always on top (Windows), 79
Always show Welcome screens (Windows), 

81
Always-on connection (Windows), 63
amount of data transferred

Mac, 112, 117
Windows, 65

antenna, external, attaching, 12
AOL, 94, 127
application, GPS (Windows only)

configuring, 99
definition, 99
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approvals, 138
arbitration of disputes, 165
ASL (Account Spending Limits), 155
assistance

online Help (Windows only), 66
Sprint Customer Service, 14
Sprint Web site, 14

authentication, 139
Auto Start GPS on connect, 84
auto-launch Sprint Connection Manager, 45
Auto-launch upon network connection 

(Windows), 64
Automatic (Network Mode) (Windows), 81
Automatic (roaming option) (Windows), 82
automatically connecting to network 

(Windows), 81
automatically starting Sprint Connection 

Manager, 45
AutoPreview, 101, 128

B
behavior when the card is locked

Mac, 119
Windows, 68

bill, 160
billing, and always on, 94, 127
blasting — hazards warning, 150
bookmarks (Windows), 70
business usage (Windows), 87

C
call duration

Mac, 116, 117
Windows, 87

cannot connect to the network (Windows), 
105

card, powering off
Mac, 115
Windows, 57

care and maintenance, 6
caution, 142
CDMA

networks, 4
roaming - description, 4
signal strength indicator (Mac), 111
signal strength indicator (Windows), 46
specification, 139

changing the lock code (Windows), 70
channel spacing, 138
charges

disputing, 161
possible charges, 158

Check for updates once per month 
(Windows), 79

Check Now button (Windows), 79
Clear Log (Windows), 88
Close Sprint Connection Manager, 61
Close Sprint Mobile Broadband (Windows), 

61
close Watcher Lite, 116
compact view (Windows)

GPS Receiver window, 60
Mobile Broadband window, 59

conditions and terms of service, 151
Connect button (Mac)

unavailable, 130
usage, 116

"Connected" message
Mac, 114
Windows, 51

connected icon (Windows), 54
"Connected to NDIS" message (Windows), 

52
"Connecting" message

Mac, 114
Windows, 51

connecting icon (Windows), 54
connecting to the network (Mac), 116
connecting to the network (Windows)

automatically, 81
manually, 62

connection (Mac)
amount of data transferred, 112, 117
ending, 117
launching, 116
states, 112

connection (Windows)
1X or 1xEV-DO (Network Mode), 81
alert log, 88
Always-on, 63
amount of data transferred, 65
application to automatically launch upon 

network connection, 64
automatically connecting when ready, 81
cannot connect, 105
diagnostics, 89
ending, 66
history, 87
issues, 88
launching, 62
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Network Mode, 81
states (GPS Receiver window), 53
states (Mobile Broadband window), 50
states (system tray), 54
warning when roaming, 63

Connection History (Windows), 87
Connection Manager

Mac. See Watcher Lite.
Windows. See Sprint Connection 

Manager.
connection states (Mac), 112
connection states (Windows)

GPS Receiver window, 53
Mobile Broadband window, 50
system tray, 54

Consent Agreement (Windows), 85
content, data, 158
contents of package, 6
Control Plane, GPS (Windows only), 96
"Could not prepare data services" message 

(Windows), 106
coverage

disclaimer, 157
LED, 136
maps, 14
type, determining (Mac), 111
type, determining (Windows), 55

Create Report (Windows), 91
current direction (Windows only), 49
current speed (Windows only), 48
current, electrical, 138
customer support, 14

D
data content, 158
data profile

Mac ("Updating User Profile"), 113
Windows, 35

data provisioning
Mac, 125
Windows, 35

data speeds, 94, 127
data transferred, amount of

Mac, 112, 117
Windows, 65

data usage, charges, 159
default connection (Windows), 62
definitions, glossary, 171
deleting Sprint Connection Manager, 71
deleting Watcher Lite, 120

deposits, 156
Device Info & Diagnostics (Windows), 89
Device LED Enabled, 82
"Device is Locked" message (Mac), 114
"Device Locked" message (Windows), 52
"Device Not Activated" window (Mac), 38
"Device powered off" message (Windows 

only), 52
diagnostics (Windows), 89
dial-up account, 94, 127
dimensions, 140
direction, current (Windows only), 49
disclaimer

network coverage, 157
Sprint Location Services (Windows only), 

162
warranties, 163

Disconnect button (Mac), 117
"Disconnected" message

Mac, 37, 113
Windows, 51

disconnected icon (Windows), 54
disconnecting

Mac, 117
Windows, 66

disk space required (Windows), 9
Display GPS Receiver (Windows only), 84
Display GPS Welcome (Windows only), 84
Display Location & Search Services on the 

menu (Windows only), 84
dispute resolution, 165
disputing charges, 161
Do not show NMEA Privacy Consent 

(Windows only), 84
Do not show Privacy Consent for Location & 

Search Services (Windows only), 85
document number, 145
dormant icon (Windows)

Mobile Broadband window, 47
system tray, 54

drop test, 140
dropped connection (Windows), 105

E
E911, 139
early termination fee, 153
editing (Windows)

Sprint Connection Manager settings, 77
Sprint Power Vision/Sprint Vision 

connection, 80
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electrical specifications, 138
electromagnetic emissions warning

Canada, 143
USA (FCC), 142

electronic serial number (ESN)
Mac, 118
Windows, 34

elevation information (Windows only), 85
EMI warning

Canada, 143
USA (FCC), 142

emissions, electromagnetic, warning
Canada, 143
USA (FCC), 142

Enable Location Services (Windows only), 84
Enable Network Adapter (NDIS) (Windows), 

81
encryption - required for IOTA (Windows), 

10
ending a connection

Mac, 117
Windows, 66

ending NMEA (Windows only), 100
enhanced Local Search (Windows only)

definition, 95
obtaining this feature, 95

environmental specifications, 140
error messages - viewing (Windows), 88
error, position (HEPE) (Windows only), 48
ESN (Electronic Serial Number)

Mac, 118
Windows, 34

EV-DO. See 1X, 1xEV-DO.
exiting Sprint Connection Manager, 61
exiting Watcher Lite, 116
expanded view (Windows)

GPS Receiver window, 60
Mobile Broadband window, 59

expanding Sprint Connection Manager, 58
ExpressCard to PC Card adapter

included in package, 6
inserting into computer, 27
removing from computer, 29

ExpressCard/34 adapter. See ExpressCard to 
PC Card adapter.

external antenna, attaching, 12

F
FAQ (Frequently Asked Questions)

Mac, 126

Windows, 93
favorites (Windows), 70
fax, 139
FCC

compliance, 142
EMI warning, 142
ID, 142

fees
early termination, 153
government, 161
late, 160

firmware upgrades, 146
fix, last (Windows only), 49
forgot the lock code

Mac, 119
Windows, 68

frequencies, transmit and receive, 138
frequency stability, 138
Frequently Asked Questions (FAQ)

Mac, 126
Windows, 93

G
General options in "Settings" window 

(Windows), 78
general terms and conditions of services, 

152
global positioning system (GPS) (Windows 

only). See GPS, Sprint Location Services, and 
also the FAQ chapter (Windows).

glossary, 171
GO automatically when ready (Windows), 

81
GO button (Windows)

GPS Receiver window, 50
Mobile Broadband window, 62
unavailable, 104

Google Maps (Windows), 85
government fees, 161
$GPGGA, 99
$GPGSA, 99
$GPGSV, 99
$GPRMC, 99
GPS (Windows only)

See also Sprint Location Services, and also 
the FAQ chapter (Windows).

accuracy, 48
application, 99
Auto Start GPS on connect, 84
Control Plane, 96
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definition, 95
disclaimer, 162
enable/disable, 84, 96
GPS Basic, 98
GPS Premium, 98
GPS Receiver window, 47
icon in system tray, 54
limitations, 97
Privacy, 96
subscription, 97
Test GPS, 85
User Plane, 96
where can I use it?, 96

GPS Basic (Windows only), 98
GPS Control Plane (Windows only), 96
GPS Port (Windows only), 49
GPS Premium (Windows only), 98
GPS Receiver window

compact view, 60
diagram with callouts, 47
expanded view, 60
icons, 48
show/hide, 84
text displayed in, 53

GPS status (Windows only)
icons, 48
text, 53

GPS Testing (Windows only), 85
GPS User Plane (Windows only), 96
GPSOne (Windows only), 98

H
hard drive space required (Windows), 9
hardware requirements

Mac, 11
Windows, 9

hazards, 150
heading (Windows only), 49
headset jack, 140
Help

overview, 14
alert log (Windows), 88
contact number, 14
device info and diagnostics (Windows), 89
diagnostics (Windows), 89
frequently asked questions (FAQ) (Mac), 

126
frequently asked questions (FAQ) 

(Windows), 93
menu options (Mac), 125
menu options (Windows), 72

online Help (Windows only), 66
Sprint Customer Service, 14
Sprint.com, 14
tests (Windows), 89
troubleshooting (Mac), 129
troubleshooting (Windows), 102

HEPE (Horizontal Estimated Position Error) 
(Windows only), 48

hibernation mode (Windows), 101
high encryption (Windows), 10
history, connection (Windows), 87
Horizontal Estimated Position Error (HEPE) 

(Windows only), 48
hospital, powering the card off in

Mac, 115
Windows, 57

humidity, 140

I
icons (Mac), 111
icons (Windows)

GPS Receiver window, 48
Mobile Broadband window, 46
system tray, 54

indemnification, 167
indicators (Mac), 111
indicators (Windows)

GPS Receiver window, 48
Mobile Broadband window, 46
system tray (Windows), 54

information, system (Windows), 89
initial lock code

Mac, 118
Windows, 67

"Initializing" message (Windows), 50
inserting the card, 27
installation

overview, 8
installed files (Windows), 91
Mac, 22
Windows, 9

integrators, information for, 144
interference

Mac, 115
Windows, 57

Internet Explorer, auto-launch (Windows), 
64

Internet Over The Air (Windows), 35
invoice, requesting a copy of, 14
IOTA 2.4 (One Touch Activation), 5, 33
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IOTA (Internet Over The Air) (Windows)
description, 35
"IOTA Provisioning" window, 35
One Touch Activation (IOTA 2.4), 5, 33
"Unable to prepare data services" 

message, 106

K
Keep Connection History (Windows), 79
knowledge base, 14

L
last fix (Windows only), 49
late fees, 160
latitude (Windows only), 48, 85
Launch when Windows starts, 79
LBS (Location-Based Services) (Windows 

only). See Sprint Location Services.
LEDs (lights), 82, 136
liability, limitation of, 146
life support equipment — hazards warning, 

150
lights (LEDs), 82, 136
Limitation of Liability, 146
limitations, Sprint Location Services 

(Windows only), 97
links, access (Windows), 70
Location & Search Services. See Sprint 

Location Services.
Location information (Windows only), 48
Location-Based Services (LBS) (Windows 

only). See Sprint Location Services.
lock card (Mac), 119
lock card (Windows)

immediately, 68
upon startup, 68

lock code - warning
Mac, 119
Windows, 68

lock code (Mac)
overview, 118
initial lock code, 118
warning, 119

lock code (Windows)
overview, 67
changing, 70
initial lock code, 67

locked card (Mac)
behavior when the card is locked, 119
initial lock code, 118

unlocking the card, 120
locked card (Windows)

behavior when the card is locked, 68
changing the lock code, 70
initial lock code, 67
unlocking the card, 69

log (Windows)
alert, 88
connection, 87

longitude (Windows only), 48, 85
lost device, 163

M
Mac OS X

system requirements, 11
See also Watcher Lite.

maintenance, 6
making a connection (Mac)

connecting to the network, 116
amount of data transferred, 112, 117

making a connection (Windows)
1X or 1xEV-DO (Network Mode), 81
always on, 81
amount of data transferred, 65
application to automatically launch upon 

network connection, 64
automatically, 81
cannot connect, 105
connecting to the network, 62
Network Mode, 81

map services (Windows only), 85
Mapping and Search Service (Windows 

only), 85
MapQuest (Windows), 85
maps, coverage, 14
mechanical specifications, 140
medical equipment — hazards warning, 

150
MEID (Mobile Equipment IDentifier) 

(Windows), 34
memory required (Windows), 9
Menu (Mac)

all options, 125
Menu (Windows)

all options, 72
About Sprint Mobile Broadband, 92
Alert Log, 88
Connection History, 87
Device Info & Diagnostics, 89
Exit, 66
Links, 70



182 Index

Location & Search Services, 55
Menu button, 49
Settings, 77
Software Updates, 91
system tray menu, 75

Menu button (Windows only), 49
menu options (Mac), 125
menu options (Windows)

Location & Search Services menu, 55
Sprint Connection Manager menu, 72
system tray menu, 75

messages - viewing (Windows), 88
messaging, text (SMS), 139
Microsoft Live (Windows), 85
Microsoft VPN (PPTP) Connection 

(Windows), 64
minimizing Sprint Connection Manager

immediately, 61
on startup, 79

minimum separation distance, 143
minus sign (-) in Sprint Connection 

Manager, 58
miscellaneous charges, 158
Mobile Broadband window

description of icons, 46
diagram with callouts, 46
expanded view, 59

Mobile Equipment IDentifier (MEID) 
(Windows), 34

Mobile IP, 139
Mobile System ID (MSID)

Mac, 39
Windows, 34

MS-Based position location technology 
(Windows only), 97, 139

MSID (Mobile System ID)
Mac, 39
Windows, 34

N
NAM, 139
NDIS (Windows)

"Connected to NDIS" message, 52
Enable Network Adapter (NDIS), 81

network
 See Sprint network.

network adapter (NDIS) (Windows), 81
Network Mode (Windows), 81
Never Ask (Roam Guard) (Windows), 64
NMEA (Windows only)

configuring the port, 100
definition, 99
starting, 100
starting automatically ("Auto Start GPS on 

connect"), 84
stopping, 100
when to use, 99

"No device" message (Windows), 50
"No device detected" message (Mac), 112
non-preactivated card

Mac, 38
Windows, 33

non-preferred roaming area (Windows), 46
"Not activated" message (Mac), 38, 113
notices

regulatory, 142
safety, 149

number of satellites (Windows only), 85

O
OEM customers, 144
"OFF" message (Windows only), 53
on top, always (Windows), 79
One Touch Activation (IOTA 2.4), 5, 33
online Help (Windows only), 66
Open Internet Connect menu option, 125
operating systems supported, 9
operating temperature, 140
optimizing performance, 101, 128
OTAPA, 139
OTASP, 139

P
package contents, 6
patents, 145
payments, 160
PC Card adapter

included in package, 6
inserting into computer, 27
removing from computer, 29

PC Card slot, using the ExpressCard in, 9
PCMCIA (PC Card) slot, using the 

ExpressCard in, 9
performance, improving, 101, 128
personal usage (Windows), 87
phone number

Mac, 118
transferring, 157
Windows, 67
Windows (during Activation Wizard), 34
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planes
hazards warning, 150
powering the card off in (Mac), 115
powering the card off in (Windows), 57

Play sound effects (Windows), 79
plus sign (+) in Sprint Connection Manager, 

58
port configuration (Windows), 89
porting/transferring phone numbers, 157
position error (HEPE) (Windows only), 48
position location (Windows only), 139

See also Sprint Location Services, and also 
the FAQ chapter (Windows).

power button, 140
power LED, 136
Power Vision, Sprint (1xEV-DO). See 1X, 

1xEV-DO.
power, transmitter, 138
powering the card on and off

Mac, 115
Windows, 57

PPTP - Microsoft VPN (PPTP) Connection 
(Windows), 64

preactivated card
Mac, 37
Windows, 32

preferred roaming list (PRL), 139
Preview Pane, 101, 128
privacy (Windows)

Consent Agreement (Sprint Location 
Services), 85

GPS not available, 96
icon (GPS Receiver window), 48

privacy, terms, 162
PRL (Preferred Roaming List), 139
problems

Mac, 129
Windows, 102

products, Sprint (Windows), 70
profile - data

Mac ("Updating User Profile"), 113
Windows, 35

properties of connection, changing 
(Windows), 80

pro-rating charges, 159
provisioning

Mac, 37, 125
Windows, 32, 35

"Provisioning failed" message (Mac), 38

Q
questions. See troubleshooting.

R
radio frequency (RF) specifications, 138
receive frequencies, 138
Receiver, GPS (Windows)

compact view, 60
diagram with callouts, 47
expanded view, 60
icons, 48
show/hide, 84
text displayed in, 53

records of connection history (Windows), 87
regulatory

information, 141
notices, 142

Relock modem when program exits 
(Windows), 68

removing
hardware (Mac), 30
hardware (Windows), 28
software (Mac), 120
software (Windows), 71

report lost or stolen device, 163
report of system information (Windows), 91
requirements, system

Mac, 11
Windows, 9

resolution of disputes, 165
restoring Sprint Connection Manager, 61
restrictions on using services, 156
returning deposits, 156
RF (radio frequency) specifications, 138
Roam Guard (Windows), 63
Roam Mode (Windows), 82
Roam Only (roaming option) (Windows), 82
roaming

description, 4
display warning message (Windows), 63
indicator (Mac), 112
indicator (Windows), 46
PRL (Preferred Roaming List), 139
settings (Windows), 82

RSSI (signal strength)
Mac, 111
Windows, 46, 89

Running Diagnostics (Windows), 89

S
Safety and Hazards, 150
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satellites (Windows only)
number of, 48, 85
status, 48

Search Services (Windows only). See Sprint 
Location Services.

"Searching for service" message
Mac, 131
Windows, 51, 104

security (Mac)
overview of user lock, 118
warning, 119
behavior when the card is locked, 119
lock card immediately, 119
unlocking the card, 120

security (Windows)
overview of user lock, 67
warning, 68
behavior when the card is locked, 68
changing the lock code, 70
high encryption - required for IOTA, 10
IOTA - high encryption requirement, 10
lock card immediately, 68
lock card upon startup, 68
unlocking the card, 69

separation distance, minimum, 143
service

conditions of, 151
coverage, determining (Mac), 111
coverage, determining (Windows), 55
LED, 136
restrictions on using, 156
roaming indicator (Mac), 112
roaming indicator (Windows), 46
"Searching for service" message (Mac), 

131
"Searching for service" message 

(Windows), 104
service charges, 159
Service Packs, Windows, 9
service plan, adding options, 14
services, Sprint (Windows), 70
"Settings" window (Windows)

overview, 77
General, 78
Sprint Location Services, 83
Sprint Mobile Broadband, 80

short text messaging (SMS), 139
shortcut menu (Windows), 75
show Welcome screens (Windows), 81
Sierra Wireless warranty, 152
signal strength

diagnostic tests (Windows), 89
indicator (Mac), 111
indicator (Windows), 46

SMS, 139
software (Mac)

components, 11
icons, 111
installing, 21
lock card immediately, 119
menu options, 125
removing, 120
uninstalling, 120
unlocking the card, 120
user lock, 118

software (Windows)
components, 11
installing, 17
lock card immediately, 68
lock card upon startup, 68
menu options, 72
minimizing, 61
minimizing on startup, 79
removing, 71
restore minimized, 61
uninstalling, 71
unlocking the card, 69
updating, 91
upgrading Windows, 107
user lock, 67
version information, 92
Windows, upgrading, 107

software specifications, 139
Software Updates (Windows), 91
sound effects, play (Windows), 79
specifications

environmental, 140
mechanical, 140
radio frequency and electrical, 138
software, 139

speed, current (Sprint Location Services) 
(Windows only), 48

speeds, data transmission, 94, 127
Sprint (roaming option) (Windows), 82
Sprint Connection Manager

overview, 44
1X or 1xEV-DO connection (Network 

Mode), 81
About Sprint Mobile Broadband, 92
amount of data transferred, 65
application to automatically launch upon 

network connection, 64
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automatically connecting when ready, 81
cannot connect, 105
closing, 61
configuring, 77
expanding Sprint Connection Manager, 

58
frequently asked questions (FAQ), 93
GPS Receiver window, 47
icons, 46
icons (GPS Receiver window), 48
icons (Mobile Broadband window), 46
icons (system tray), 54
links, 70
menu options, 72
minimizing, 61
minimizing on startup, 79
Mobile Broadband windowr, 46
Network Mode, 81
removing, 71
restoring, 61
security features, 67
settings, 77
Sprint Location Services, 55
starting, 44
starting automatically, 45
stopped working after Windows upgrade, 

107
system tray menu, 75
uninstalling, 71
updating, 91
upgrading Windows, 107
version information, 92
window overview, 45
Windows upgrade, 107

Sprint Connection Manager settings
1X or 1xEV-DO connection (Network 

Mode), 81
changing, 77
General, 78
Sprint Location Services, 83
Sprint Mobile Broadband, 80

Sprint Connection Manager stopped 
working after I’ve upgraded to a different 
version of Windows, 107

Sprint Customer Service, 14
Sprint Location Services (Windows only)

See also GPS, and also the FAQ chapter 
(Windows).

Auto Start GPS on connect, 84
definition of LBS (Location-Based 

Services), 94
disclaimer, 162

display Location & Search Services on the 
menu, 84

enable/disable, 84, 96
frequently asked questions, 95
GPS Receiver window, 47
icon in system tray, 54
icons, 48
limitations, 97
Location & Search Services menu, 55
Privacy, 96
settings, 83
subscription, 97
Test GPS, 85
text in GPS Receiver window, 53
troubleshooting, 105
using, 55

Sprint Mobile Broadband card
inserting, 27
phone number (Mac), 118
phone number (Windows), 67
removing (Mac), 30
removing (Windows), 28

Sprint network
1X or 1xEV-DO connection (Network 

Mode) (Windows), 81
always on connection (Windows), 81
amount of data transferred (Mac), 112, 

117
amount of data transferred (Windows), 

65
application to automatically launch upon 

network connection (Windows), 64
automatically connecting when ready 

(Windows), 81
availability status (Windows), 89
cannot connect (Windows), 105
CDMA wireless network, description, 4
connecting (Mac), 116
connecting (Windows), 62
coverage, determining (Mac), 111
coverage, determining (Windows), 55
coverage, disclaimer, 157
frequently asked questions (FAQ) (Mac), 

126
frequently asked questions (FAQ) 

(Windows), 93
LED (coverage detected), 136
roaming indicator (Mac), 112
roaming indicator (Windows), 46
roaming options (Windows), 82
signal strength indicator (Mac), 111
signal strength indicator (Windows), 46
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Sprint Location Services (Windows only), 
55

Sprint Power Vision (1xEV-DO). See 1X, 
1xEV-DO.

Sprint products and services (Windows), 70
Sprint roaming (Windows), 82
Sprint Vision

1X or 1xEV-DO connection (Network 
Mode) (Windows), 81

Always show Welcome screens 
(Windows), 81

amount of data transferred (Mac), 112, 
117

amount of data transferred (Windows), 
65

application to automatically launch upon 
network connection (Windows), 64

automatically connecting when ready 
(Windows), 81

cannot connect (Windows), 105
connecting (Mac), 116
connecting (Windows), 62
coverage, determining (Mac), 111
coverage, determining (Windows), 55
disconnecting (Mac), 117
disconnecting (Windows), 66
ending a connection (Mac), 117
ending a connection (Windows), 66
Network Mode (Windows), 81
settings (Windows), 80
warning when roaming (Windows), 63
See also 1X, 1xEV-DO.

Sprint Web site, 14
Sprint, contacting, 14
sprint.com, 14
standby current, 138
Start in system tray (Windows), 79
starting a connection (Mac), 116
starting a connection (Windows)

application to automatically launch upon 
network connection, 64

automatically connecting when ready, 81
immediately, 62
specify 1X or 1xEV-DO connection 

(Network Mode), 81
warning when roaming, 63

starting NMEA (Windows only), 100
starting Sprint Connection Manager

automatically, 45
manually, 44

starting Watcher Lite, 111

status information (Windows), 89
status of connection (Mac), 112
status of connection (Windows)

GPS Receiver window, 53
Mobile Broadband window, 50
system tray, 54

stolen device, 163
Stop button (Windows)

GPS Receiver window, 50
Mobile Broadband window, 66

stopping NMEA (Windows only), 100
storage temperature, 140
subscriber agreement, 152
subscription, GPS (Windows only), 97
support, 14
surcharges, 161
suspend mode, 136
system information (Windows), 89, 91
System Parameters (Windows), 91
system requirements

Mac, 11
Windows, 9

system tray (Windows)
connection states, 54
icons, 54
menu, 75
shortcut menu, 75
start in, 79

T
taskbar icon (Windows)

shortcut menu, 61
taxes, 161
technical specifications, 135
technical support, 14
telephone number of card

Mac, 118
Windows, 67

temperature (operating, and storage), 140
termination fee, 153
Terms and Conditions, 151
terms and definitions (glossary), 171
Test GPS (Windows only), 85
tests, diagnostic (Windows), 89
text messaging (SMS), 139
trademarks, 145
transferred data, amount of

Mac, 112, 117
Windows, 65

transferring phone numbers, 157
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transmission speeds, 94, 127
transmit frequencies, 138
transmit/receive icon (Windows), 46, 47
transmitter power, 138
trilateration (Windows only), 97
troubleshooting (Mac)

common causes of problems, 130
Connect button is unavailable, 130
contact information, 14
frequently asked questions (FAQ), 126
"Searching for service" message, 131

troubleshooting (Windows)
common causes of problems, 103
alert log, 88
cannot connect, 105
contact information, 14
"Could not prepare data services" 

message, 106
frequently asked questions (FAQ), 93
GO button is unavailable, 104
run diagnostic tests, 89
"Searching for service" message, 104
Sprint Connection Manager stopped 

working after Windows upgrade, 107
Sprint Location Services, 105
Troubleshooting wizard, 14
"Unable to prepare data services" 

message, 106
wizard, 14

Troubleshooting wizard (Windows), 14
TRU-Install, 5
TTY, 139
type of coverage, determining

Mac, 111
Windows, 55

U
uninstalling Sprint Connection Manager, 71
uninstalling Watcher Lite, 120
unlocking the card (Mac)

initial lock code, 118
instructions, 120

unlocking the card (Windows)
initial lock code, 67
instructions, 69

Update Data Profile (Windows), 35
updates, checking for latest, 146
updating the software (Windows), 91
"Updating User Profile…" message

Mac, 38, 39, 113
Windows, 35

upgrading Windows, 107
URL to automatically launch upon network 

connection (Windows), 64
URLs - favorites (Windows), 70
USB port (Windows), 89
user lock (Mac)

overview, 118
warning, 119
lock card immediately, 119
unlocking the card, 120

user lock (Windows)
overview, 67
warning, 68
changing the lock code, 70
lock card immediately, 68
lock card upon startup, 68
unlocking the card, 69

User Lock Change button (Windows), 82
User Plane, GPS (Windows only), 96

V
"Validating" message (Windows), 53
vehicle, operating

hazards warning, 150
version information

Mac ("About Sprint Device" window), 118
Windows, 92

version of this document, 145
vibration, 140
views of Sprint Connection Manager, 58
Vision. See Sprint Vision, and 1X, 1xEV-DO.
Vista, Windows, 9
voice support, 139
voltage, 138
VPN (Mac)

accessing your corporate network 
through a VPN, 128

VPN (Windows)
accessing your corporate network 

through a VPN, 100
specifying a VPN program to 

automatically launch upon network 
connection, 64

W
warning

electromagnetic emissions (EMI) — 
Canada, 143

electromagnetic emissions (EMI) — USA 
(FCC), 142

lock code, regarding (Mac), 119
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lock code, regarding (Windows), 68
roaming, display message (Windows), 63

warranties, disclaimer of, 163
Warranty and Terms and Conditions, 151
Watcher Lite

overview, 111
amount of data transferred, 117
closing, 116
diagram with callouts, 111
frequently asked questions (FAQ), 126
icons, 111
installing, 21
menu options, 125
removing, 120
security features, 118
starting, 111
uninstalling, 120

weak signal
Mac, 131
Windows, 104

Web site - Sprint.com, 14
Web site (Windows)

automatically launch upon network 
connection, 64

favorites, 70
Welcome screen, always show (Windows), 

81
Windows

auto-launch Sprint Connection Manager, 
79

upgrading, 107
versions supported, 9

Wireless Local Number Portability (WLNP)
Mac, 39
Windows, 34

wizard (Mac) - Activation Assistant, 37, 38
wizard (Windows)

Activation Wizard, 32
Troubleshooting, 14

WLNP (Wireless Local Number Portability)
Mac, 39
Windows, 34

www.sprint.com, 14

X
XP, Windows, 9

Y
Yahoo! Maps (Windows), 85
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